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Περίληψη 

Στην παρούσα εργασία μελετάται η δυναμική αλληλεπίδραση της μικροφυσαλίδας 

με γειτονικό στερεό τοίχωμα υπό την επίδραση ακουστικών διαταραχών με τη χρήση 

υπολογιστικής πλατφόρμας. Τα αποτελέσματα της συγκρίνονται με κώδικες 

συνοριακών στοιχείων, ώστε να ταυτοποιηθεί η ακρίβεια της προσομοίωσης 

(Benchmark Test). Έπειτα γίνεται μελέτη και προσομοίωση του προβλήματος με την 

εισαγωγή του ιξώδους, με σκοπό να μελετηθεί η επίδρασή του στην συμπεριφορά της 

φυσαλίδας. Το μοντέλο για την προσομοίωση δημιουργήθηκε με τη χρήση 

υπολογιστικής πλατφόρμας ANSYS Fluent, όπου σχεδιάστηκε με τις κατάλληλες 

παραμέτρους, ορίστηκαν οι αρχικές συνθήκες του προβλήματος και τέλος έγινε η 

εξαγωγή των αποτελεσμάτων με τη μορφή οπτικών μέσων και διαγραμμάτων. Από τα 

πρώτα αποτελέσματα γίνεται φανερό ότι δεν έχει ιδιαίτερη επίδραση το ιξώδες στην 

συμπεριφορά της φυσαλίδας. Η φυσαλίδα πλησιάζοντας στο τοίχωμα φαίνεται να 

καθυστερεί με την παρουσία του ιξώδους. Επίσης υπάρχει απόσβεση ενέργειας στην 

επιφάνεια της φυσαλίδας, καθώς και απόσβεση των ταλαντώσεων όγκου της. 
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Abstract 

In this Thesis we study the dynamic interaction of microbubble with an adjacent 

rigid wall in the presence of acoustic disturbances by using a computational platform. 

In order to identify the accuracy of the simulation (Benchmark Test), the results are 

gathered and compared with boundary element codes. Then we study and simulate the 

problem with the introduction of viscosity in order to observe its effect on the behavior 

of the bubble. The model for the simulation created using computational platform 

ANSYS Fluent, which was designed with the appropriate parameters, set the initial 

conditions of the problem and finally the results are exported in the form of optical 

instruments and charts. From the first results, it is evident that no particular effect on 

the viscosity behavior of the bubble. The bubble approaching the wall seems to be 

delayed by the presence of viscosity. Also there is damping energy to the surface of the 

bubble and damping volume. 
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Zusammenfassung 

In dieser Diplomarbeit untersuchen wir der dynamischen Wechselwirkung von 

Mikrobläschen mit einer benachbarten starren Wand in Gegenwart von akustischen 

Störungen durch Verwendung ein Rechenplattform. Um die Genauigkeit der 

Simulation (Benchmark Test) zu identifizieren, die Ergebnisse werden mit Boundary-

Element-Codes verglichen. Dann wird das Problem der Einführung der Viskosität 

untersucht und simuliert, um seine Wirkung auf das Verhalten der Blase zu testen. Das 

Modell für die Simulation wurde mit ANSYS Fluent Rechenplattform geschaffen, das 

mit den entsprechenden Parametern entworfen wurde, wurde die Anfangsbedingungen 

des Problems festgesetzt und der Export der Ergebnisse in Form von optischen und 

Charts durchgeführt. In den ersten Ergebnissen ist ersichtlich, dass keine besondere 

Wirkung auf das Viskositätsverhalten der Blase nachzuweisen ist. Die Annäherung an 

die Blasenwand scheint durch die Anwesenheit von Viskosität verzögert zu werden. 

Auch gibt es Dämpfungsenergie auf der Oberfläche der Blase so wie auch auf dem 

Dämpfungsvolumen. 
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1. Εισαγωγή 

Η προσπάθεια της ανθρώπινης κοινωνίας για βελτίωση των συνθηκών ζωής έχει 

συνδυαστεί αναπόσπαστα με την πρόοδο της Μηχανικής και της Ιατρικής. Τις τελευταίες δεκαετίες 

η πρόοδος της τεχνολογίας είναι ραγδαία καθώς εκμεταλλεύεται όλο το θεωρητικό υπόβαθρο 

προηγούμενων περιόδων και με την βελτίωση των υλικών είναι πλέον εύκολο να κατανοηθεί αυτό 

που αποκαλείται σύγχρονος τρόπος ζωής. Οι ιστορίες επιστημονικής φαντασίας θέλουν η θεραπεία 

μιας μολυσμένης περιοχής να γίνεται χωρίς χειρουργικά εργαλεία, αίμα και πόνο, αλλά με το 

πέρασμα ενός οργάνου επάνω από την πάσχουσα περιοχή. Η σύγχρονη επιστήμη μπορεί να μην το 

έχει καταφέρει ακόμα, όμως έχει γίνει ιδιαίτερη πρόοδος σε αυτή την κατεύθυνση. Οι 

μικροφυσαλίδες τύπου (contrast agent) είναι μια μέθοδος που θα επιτρέπει την ανώδυνη θεραπεία 

προσφέροντας στοχευμένη απελευθέρωση φαρμάκου χωρίς χειρουργική επέμβαση. 

1.1 Κίνητρο και υπόβαθρο 

Η μελέτη των μικροφυσαλίδων είναι ένα ιδιαίτερα διεπιστημονικό πεδίο καθώς 

συγκεντρώνει γνώση από διάφορους τομείς της επιστήμης. Ήδη από τις αρχές του περασμένου 

αιώνα ξεκίνησαν μελέτες για την δομή των κυττάρων, ανοίγοντας έτσι το δρόμο στη μελέτη των 

μικροφυσαλίδων. Οι μικροφυσαλίδες έχουν ένα ευρύ πεδίο τεχνολογικών εφαρμογών όπως η 

ιατρική, η βιομηχανία τροφίμων, τα καλλυντικά, καθώς και η βιομηχανία χαρτιού. Ωστόσο ο πιο 

δυναμικός κλάδος που εμπλέκονται οι μικροφυσαλίδες είναι η ιατρική και ιδιαίτερα η στοχευμένη 

διανομή φαρμάκου καθώς και η ιατρική απεικόνιση ζωτικών οργάνων. Στην πρώτη περίπτωση ο 

βασικός σκοπός των μικροφυσαλίδων είναι να αναγνωρίσουν και να προσκολληθούν σε 

συγκεκριμένες περιοχές του σώματος που πάσχουν από κάποια ασθένεια και να απελευθερώσουν 

φάρμακο στην πάσχουσα περιοχή μόνο, την επιθυμητή χρονική στιγμή[1]. Επίσης μπορούν να 

χρησιμοποιηθούν και για γονιδιακή θεραπεία, όπως είναι η μέθοδος Sonoporation, με την οποία 

γίνεται δημιουργία πόρων στην επιφάνεια γειτονικών κυττάρων εξαιτίας του ροϊκού πεδίου που 

δημιουργεί η ταλαντούμενη μικροφυσαλίδα [2]. Ενώ στη δεύτερη περίπτωση, χρησιμοποιούνται 

φυσαλίδες που περιέχουν κάποιο αέριο (πχ άζωτο) και σε συνδυασμό με υπερήχους επιτρέπουν την 

απεικόνιση κάποιου οργάνου [3]. 

Ο σχεδιασμός τέτοιων μικροφυσαλίδων απαιτεί την κατανόηση των φυσικών ιδιοτήτων. 

Πιο συγκεκριμένα ιδιαίτερο ρόλο παίζουν η μεταβολή του όγκου της φυσαλίδας καθώς και του 

κέντρου μάζας σύμφωνα με το πέρασμα του χρόνου. Επίσης ιδιαίτερο ρόλο κατέχει και το 

ιξώδες, το οποίο συμβάλλει σημαντικά στην συμπεριφορά της φυσαλίδας. Ο σκοπός της 

παρούσας εργασίας είναι η μελέτη της μεταβολής του κέντρου μάζας και του όγκου της 

φυσαλίδας με το χρόνο καθώς και του ιδιαίτερου ρόλου που παίζει το ιξώδες στη ροή και στη 

συμπεριφορά της φυσαλίδας κοντά στο τοίχωμα. Η συγκεκριμένη εργασία βασίζεται σε 

προηγούμενες μελέτες που έχουν γίνει και σαν πρώτη φάση γίνεται μία σύγκριση των 

αποτελεσμάτων που λήφθηκαν από το πακέτο λογισμικό ANSYS Fluent με τα αποτελέσματα 

από κώδικες Fortran με χρήση πεπερασμένων συνοριακών στοιχείων. Έπειτα, αφού έγινε η 

ταυτοποίηση των αποτελεσμάτων με τους κώδικες, εξήχθησαν κάποια νέα αποτελέσματα, όσον 

αφορά τη συμπεριφορά της φυσαλίδας σε ιξώδες ρευστό, τα οποία και θα λειτουργήσουν ως 

αρχικές προβλέψεις. Δυστυχώς δεν έχουν δημοσιευτεί ακόμα υπολογιστικές μελέτες, με τις 

οποίες θα μπορέσει να γίνει σύγκριση των αποτελεσμάτων από την συγκεκριμένη υπολογιστική 

πλατφόρμα.  
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Εικόνα 1-1: Θεραπεία ασθενειών εσωτερικών οργάνων με μεταφορά φαρμάκων στους ιστούς από τις 

μικροφυσαλίδες. 

1.2 Βιβλιογραφική Ανασκόπηση 

Σημαντική πειραματική δουλειά έχει γίνει από τους Vos και Dollet [4], καθώς και από τους 

Zhao, Ferrara, Dayton [5]. Πειράματα έχουν δείξει ότι η παρουσία ενός κοντινού στερεού 

τοιχώματος επηρεάζει ταλαντώσεις της φυσαλίδας και ειδικότερα τη μέγιστη επέκτασή της. Επίσης 

έχουν παρατηρηθεί ασύμμετρες ταλαντώσεις, σπειροειδείς μορφές φυσαλίδας κατά τη διάρκεια 

έναρξης υγρής δέσμης υψηλής ταχύτητας «jet». Τέλος η φυσαλίδα ταλαντώνεται ασύμμετρα στο 

επίπεδο κάθετο προς τον τοίχο, ενώ ταλαντώνεται συμμετρικά στο επίπεδο, το οποίο είναι 

παράλληλο προς το τοίχωμα (δηλαδή η παραμόρφωση έχει προσανατολισμό κάθετα προς τον 

τοίχο). Αυτά φαίνονται στις παρακάτω εικόνες, Εικόνα 1-2, Εικόνα 1-3.  

 

Εικόνα 1-2: Η καταστροφή της προσκολλημένης μικροφυσαλίδας στο φυσιολογικό επίπεδο απεικόνισης. 
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Εικόνα 1-3: Οπτικές εικόνες της φυσαλίδας κατά τη διάρκεια δύο κύκλων του παλμού υπερήχων. Ο πάνω πίνακας 

δείχνει την πάνω όψη της φυσαλίδας σε διαφορετικούς χρόνους των 138 ns. Ο κάτω πίνακας δείχνει το ίδιο τμήμα 

των ταλαντώσεων της φυσαλίδας στην πλάγια όψη, το οποίο καταγράφεται 2 λεπτά αργότερα. Το τοίχωμα 

εμφανίζεται ως γκρι περιοχή στην κορυφή. Η διάμετρος της φυσαλίδας (αριστερά) ήταν 9μm. 

Επίσης έχει γίνει σημαντική μελέτη [6], τα αποτελέσματα της οποίας φαίνονται στην Εικόνα 

1-4. Η παρακάτω εικόνα δείχνει την κίνηση μιας φυσαλίδας ατμού κοντά σε ένα γειτονικό 

στερεό τοίχωμα. Στην αρχή φαίνεται η φυσαλίδα κατά την έναρξη των υπολογίσμων, στη 

συνέχεια ο μέγιστος όγκος της και τέλος η δημιουργία υγρής δέσμης υψηλής ταχύτητας «jet», 

όταν πλησιάζει κοντά στο στερεό τοίχωμα. Η επίδραση του «jet» φαίνεται να περνά από το 

κέντρο της φυσαλίδας, όπου γίνεται η κατάρρευση της φυσαλίδας μέχρι τη στιγμή που 

προσκολλάται στο τοίχωμα. 

 
Εικόνα 1-4: Στιγμιότυπα της κίνησης μιας φυσαλίδας ατμού κοντά σε ένα στερεό τοίχωμα. 

 

Αξιοσημείωτη δουλειά ακόμα έχει γίνει [7], όπως φαίνεται και στην Εικόνα 1-5, όπου η 

φυσαλίδα εμφανίζεται στο μέγιστο όγκο της και σε μεταγενέστερες χρονικές στιγμές υπάρχει η 

δημιουργία ενός λεπτού «jet», το οποίο εμφανίζεται στον ελάχιστο όγκο της φυσαλίδας, όπου 

και γίνεται η κατάρρευσή της. 
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Εικόνα 1-5: Φάσεις της φυσαλίδας σε διάφορες χρονικές στιγμές. (α) Η φυσαλίδα στη μέγιστη ακτίνα της και 

εμφάνιση «jet» στον ελάχιστο όγκο της φυσαλίδας. 

Ακόμα σημαντική μελέτη στη συμπεριφορά των φυσαλίδων έχει γίνει και από τους 

Τσαμόπουλο και Πελεκάση [8], η οποίοι μελέτησαν την αλλήλεπίδραση της φυσαλίδας με μία 

άλλη αντίστοιχη φυσαλίδα. Τα αποτελέσματα φαίνονται ενδεικτικά στην παρακάτω Εικόνα 1-6, 

όπου παρατίθενται τα σχήματα της φυσαλίδας σε διάφορες χρονικές στιγμές με την παρουσία 

αντίστοιχης φυσαλίδας. 

 
Εικόνα 1-6: Σχήματα της φυσαλίδας που λαμβάνονται κατά τη διάρκεια των υπολογισμών για διάφορες 

χρονικές στιγμές. 

Σημαντική εργασία αλληλεπίδραση φυσαλίδας με ιξώδες που έχει γίνει [10], φαίνεται στην 

παρακάτω Εικόνα 1-7, που δείχνει τη σύγκριση πειραματικών με υπολογιστικών 

αποτελεσμάτων. Υπάρχει καλή συμφωνία της σύγκρισης των αποτελεσμάτων με την αρχική 

εμφάνιση υγρής δέσμης υψηλής ταχύτητας «jet» να είναι ποσοτικά και ποιοτικά παρόμοια. Και 

το πείραμα και η προσομοίωση δείχνει την επίδραση του «jet» στην αντίθετη πλευρά της 

φυσαλίδας, ενώ το «jet» διαστέλλει την επιφάνεια της. Επίσης παρατηρείται ότι το ιξώδες 

βοηθάει στην απόσβεση ενέργειας στην επιφάνεια της φυσαλίδας, με τη δημιουργία λιγότερων 

διαταραχών. 
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Εικόνα 1-7: Σύγκριση μεταξύ πειραματικών και υπολογιστικών αποτελεσμάτων. 

Οι αριθμητικές προσομοιώσεις των ροών με διεπιφάνεια και ροές με ελεύθερη επιφάνεια 

είναι ένα τεράστιο θέμα, με εφαρμογές σε τομείς τόσο διαφορετικούς όπως το περιβάλλον, τη 

γεωφυσική, τη μηχανική και τη στοιχειώδης φυσική. Στη συγκεκριμένη εργασία 

χρησιμοποιήθηκε η μέθοδος του όγκου ρευστού, την οποία πρώτοι χρησιμοποίησαν οι Hirt και 

Nichols [11]. Σε αυτή τη μέθοδο χρησιμοποίησαν πρώτης τάξης ακρίβεια για την ανακατασκευή 

της διεπιφάνειας. Τυπικά, η ανακατασκευασμένη διεπιφάνεια αποτελείται από μια ακολουθία 

τμημάτων, τα οποία ευθυγραμμίζονται με το πλέγμα, όπως φαίνεται στην παρακάτω εικόνα: 

 
Εικόνα 1-8: Μία προσπάθεια ανακατασκευής της διεπιφάνειας με πρώτης τάξης ακρίβεια ή απλός γραμμικός 

υπολογισμός διεπιφάνειας. 
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Όμως η ανακατασκευή είναι γενικά αργή, οπότε και χρησιμοποιείται μεγαλύτερης τάξης 

ακρίβεια, η οποία χρησιμοποιήθηκε και στην παρούσα μελέτη. Αυτή φαίνεται στην παρακάτω 

εικόνα, η οποία δείχνει τη δεύτερη τάξης ακρίβεια: 

 
Εικόνα 1-9: Δεύτερης τάξης ακρίβεια ή τμηματική κατασκευή γραμμικής διεπιφάνειας. 

1.3 Οργάνωση Πτυχιακής Εργασίας 

Το υπόλοιπο κομμάτι της εργασίας χωρίζεται σε τέσσερις ενότητες που καταλαμβάνουν οι 

ενότητες από 2 έως 5. Συγκεκριμένα στην ενότητα 2 (Θεωρητική Ανάλυση) αναπτύσσεται η 

θεωρία στην οποία βασίζεται η παρούσα εργασία και γίνεται η σύγκριση των αποτελεσμάτων για 

την ταυτοποίηση της υπολογιστικής πλατφόρμας. Στην ενότητα 3 (Αριθμητική Ανάλυση) 

περιγράφεται η αριθμητική ανάλυση του προβλήματος. Στην ενότητα 4 (Αποτελέσματα) 

παρατίθενται τα αποτελέσματα της εργασίας σε κατάλληλα διαγράμματα καθώς και εικόνες σε 

διάφορες χρονικές στιγμές. Τέλος στην ενότητα 5(Συμπεράσματα-Προτάσεις για μελλοντική 

εργασία) παρουσιάζονται τα τελικά συμπεράσματα της πτυχιακής εργασίας, καθώς και 

κατευθύνσεις για περαιτέρω έρευνα στον τομέα αυτό. 
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2. Θεωρητική Ανάλυση 

Σε αυτή την ενότητα επιχειρείται να δοθεί μια σύντομη περιγραφή του προβλήματος και του 

θεωρητικού υποβάθρου πίσω από τη μέθοδο VOF. 

2.1 Διατύπωση προβλήματος 

Θεωρείται μια έγκλειστη μικροφυσαλίδα με μέση (equilibrium) ακτίνα Req βυθισμένη σε 

ένα νευτονικό ρευστό πυκνότητας ρl, δυναμικού ιξώδους μl και στατικής πίεσης PAtm. Στο 

εσωτερικό της η φυσαλίδα περιέχει εσώκλειστο ιδανικό αέριο ορισμένης πίεσης, όπως φαίνεται 

και στην Εικόνα 2-1, η οποία είναι αντίστοιχη με την εικόνα 1 από προηγούμενη μελέτη [12]. 

 
Εικόνα 2-1: Γεωμετρική απεικόνιση της έγκλειστης μικροφυσαλίδας στο πλαίσιο της παρούσας μελέτης 

Ένα κύμα ημιτονοειδούς πίεσης επιβάλλεται στη μια συνοριακή συνθήκη (στο άπειρο) και 

χαρακτηρίζεται από ένα πλάτος ε και από μία συχνότητα εξωτερικής διαταραχής ωf, όπως 

φαίνεται και στην παρακάτω εξίσωση: 

  1 cosAtm fP P t      2-1 

Σε ισορροπία το ρευστό που περιβάλλει τη μικροφυσαλίδα είναι σε ηρεμία και η πίεση μέσα 

στη φυσαλίδα είναι συνδεδεμένη με αυτή στη συνοριακή συνθήκη κοντά στο άπειρο με την 

εξίσωση, 

     
2

0 0 , ( 0) ,


       G l l l AtmP t P t P t P r t P
R   

2-2
 

Ενώ κατά την διάρκεια της κίνησης το κάθετο και εφαπτομενικό ισοζύγιο δυνάμεων 

πάνω στην διεπιφάνεια της φυσαλίδας παίρνει την μορφή 
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    
 

( ) 2

0

           

    

T

G l

T

P t P t n u u n H n

t u u n
  2-3 

Όπου σ είναι η μέση επιφανειακή τάση της διεπιφάνειας αέριου- ρευστού και 2H η μέση 

καμπυλότητα σε κάθε σημείο της εξωτερικής επιφάνειας της φυσαλίδας.. 

Το σχήμα της φυσαλίδας υποτίθεται ότι είναι αξονοσυμμετρικό κάθε στιγμή, ενώ το αρχικό 

σχήμα είναι ελλειψοειδές. Στην παρούσα ανάλυση θα θεωρηθεί ότι η μικροφυσαλίδα έχει αρχικό 

σφαιρικό σχήμα. Το χρονοδιάγραμμα των ταλαντώσεων της μικροφυσαλίδας προσδιορίζεται 

από συχνότητα εξωτερικής διαταραχής, ωf. 

Λαμβάνοντας υπόψη ασυμπίεστη ροή, οι ακόλουθες εξισώσεις διέπουν την κίνηση στο 

περιβάλλον του ρευστού: 

Εξίσωση συνέχειας που εκφράζει το διαφορικό ισοζύγιο μάζας, 

 0V    2-4
 

Εξισώσεις NavierStokes που εκφράζουν το διαφορικό ισοζύγιο ορμής, 

 

2  
dV

V V P V
dt

     
  

2-5
 

,όπου η επίδραση της βαρύτητας αγνοείται εξαιτίας του μικρού μεγέθους των φυσαλίδων. 

Θεωρείται ασυμπίεστη ροή και σταθερό ιξώδες. Η παραπάνω εξίσωση εκφράζει τη δυναμική 

ισορροπία των εξής μεταβαλλόμενων όρων:  

 Των δυνάμεων αδράνειας. 

 Των εξωτερικών δυνάμεων (συνήθως δυνάμεων βαρύτητας). 

 Των δυνάμεων που προκύπτουν από τις διαφορές πίεσης. 

 Των δυνάμεων του ιξώδους. 

Ήρεμες συνθήκες ροής στο άπειρο, 

: 0, Atmr V P P P   
. 

,όπου PAtm συμβολίζει την συνήθη ατμοσφαιρική πίεση, 1.01x10
5
 Pa. 

Εξαιτίας της αμελητέας πυκνότητας και του κινηματικού ιξώδους του αερίου μέσα στη 

φυσαλίδα λαμβάνεται ως ομοιόμορφη η κατανομή της πίεσης της φυσαλίδας και αγνοείται το 

αποκλίνον μέρος του τανυστή των τάσεων στην πλευρά του αερίου μέσα στη φυσαλίδα. 

Επιπρόσθετα, λόγω του πολύ σύντομου χρονικού διαστήματος που εξελίσσονται τα φαινόμενα 

στην παρούσα μελέτη, σαν πρώτη προσέγγιση, θεωρούνται ισοθερμικές ταλαντώσεις. Κατά 

συνέπεια η διακύμανση της πίεσης της φυσαλίδας σε σχέση με το χρόνο δίνεται από: 

 

3

0

4
( 0) ( ) ( )

3



G G GP t R P t V t
 

  
    

2-6 
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Μια σημαντική βελτίωση της μοντελοποίησης της μηχανικής συμπεριφοράς των φυσαλίδων 

είναι να θεωρηθεί ότι οι φυσαλίδες δεν είναι άδειες, αλλά περιέχουν κάποιο ιδανικό αέριο. Στη 

συγκεκριμένη εργασία έχει θεωρηθεί αέρας ως ιδανικό αέριο. 

Στην συγκεκριμένη περίπτωση όμως θεωρείται ισοθερμοκρασιακή μεταβολή, οπότε η 

πολυτροπική σταθερά γ=1. 

Για τις αρχικές συνθήκες,
0

t t  λαμβάνεται: 

 Ότι η πίεση του νερού είναι Patm και του αέρα είναι  
2

0


G AtmP t P
R

    

Για λίγο μετά, δηλαδή 
0

t t   επιβάλλεται στο ρευστό και αρκετά μακριά από το τοίχωμα 

μία ακουστική διαταραχή: 

  : 0, 1 cos Atm fr V P P P t      

 
Εικόνα 2-2: Η διάταξη του προβλήματος στο περιβάλλον του Fluent 

όπου,  

 Στη διεπιφάνεια υπάρχει μηδενική εφαπτομενική τάση: t n 0   , όπου   συμβολίζει 

 τον τανυστή των ιξωδών τάσεων ενώ t , n,  συμβολίζουν το εφαπτομενικό και το κάθετο 

 διάνυσμα αντίστοιχα, επάνω στην διεπιφάνεια φυσαλίδας ρευστού. 
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 ( 0) 2 GP t P H n n       , όπου Η συμβολίζει την μέση καμπυλότητα στην διεπιφάνεια 

της φυσαλίδας και το κάθετο διάνυσμα, n , δείχνει προς τα έξω σε σχέση με  την φυσαλίδα, 

όπως φαίνεται στην Εικόνα 2-1. 

 Επιφανειακή τάση 0,072 Ν/m. 

 Ισοθερμοκρασιακές μεταβολές. 

2.2 Μέθοδος Όγκου Ρευστού (Volume of fluid Method) 

2.2.1 Εισαγωγή 

Η μέθοδος όγκου ρευστού (Volume of Fluid (VOF) model) είναι σχεδιασμένη για δύο ή 

περισσότερα μη αναμίξιμα  ρευστά, στα οποία είναι σημαντική η θέση της μεταξύ τους 

διεπιφάνειας. Στη μέθοδο αυτή ένα ενιαίο σύνολο των εξισώσεων ορμής χρησιμοποιείται από τα 

ρευστά και το κλάσμα όγκου (volume of fraction) καθενός από τα ρευστά  παρακολουθείται σε 

όλο το χωρίο (domain) [11]. 

Η μέθοδος όγκου ρευστού βασίζεται στο γεγονός ότι δύο ή περισσότερα ρευστά δεν είναι 

διαπερατά το εάν από το άλλο. Για κάθε επιπλέον φάση που προστίθεται στο μοντέλο, εισάγεται 

μια μεταβλητή, η οποία είναι το κλάσμα όγκου της συγκεκριμένης φάσης. Σε κάθε όγκο 

ελέγχου, το άθροισμα των κλασμάτων όγκου από όλες τις φάσεις είναι μονάδα. Τα πεδία για 

όλες τις μεταβλητές και ιδιότητες χρησιμοποιούνται από όλες τις φάσεις, εφόσον το κλάσμα 

όγκου της καθεμίας από τις φάσεις είναι γνωστό σε κάθε θέση. Αν το κλάσμα όγκου του k
th

 

ρευστού σε ένα πολυφασικό σύστημα συμβολίζεται ως εk, τότε οι ακόλουθες τρεις συνθήκες 

είναι δυνατές: 

 

 

0

1

0 1

k

k

k











 

 

 

Με βάση την τοπική τιμή του εk, οι κατάλληλες ιδιότητες και μεταβλητές θα ανατεθούν σε 

κάθε όγκο ελέγχου εντός του χωρίου. 

Τα πλεονεκτήματα της μεθόδου αυτής είναι γνωστά για πολλές δεκαετίες και έχουν περάσει 

από μια συνεχή διαδικασία βελτίωσης. Η χρήση τους και αποτελεσματικότητα τους είναι ευρέως 

διαδεδομένες για τους παρακάτω λόγους [13]: 

1. Διατηρούν μάζα με φυσικό τρόπο, ως άμεση συνέπεια της ανάπτυξης ενός 

αλγορίθμου μεταφοράς, ο οποίος βασίζεται σε διακριτή  αναπαράσταση του νόμου 

διατήρησης. 

2. Δεν υπάρχει κάποια ειδική ρύθμιση για την διατήρηση ή καταστροφής της 

διεπιφάνειας, υπό αυτή την έννοια η αλλαγή της τοπολογίας είναι αυτονόητη στον 

αλγόριθμο. 

3. Μπορούν σχετικά απλά να επεκταθούν από δύο διαστάσεων χωρία σε τριών 

διαστάσεων χωρία. 

το κελί είναι άδειο από το kth ρευστό. 

το κελί είναι γεμάτο από το kth ρευστό. 

το κελί περιέχει τη διεπιφάνεια ανάμεσα στα 

ρευστά. 
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2.2.2 Εξίσωση Κλάσματος Όγκου 

 Η παρακολούθηση της διεπιφάνειας ανάμεσα στις φάσεις επιτυγχάνεται από τη λύση 

εξίσωσης συνέχειας για το κλάσμα όγκου μίας ή και περισσότερων από τις φάσεις. Για την kth 

φάση, η εξίσωση έχει τη μορφή: 

 
k

k k
j

i

u S
t x



  
 

 
  2-7 

Ο όρος πηγής στο δεξί μέλος της παραπάνω εξίσωσης είναι κανονικά μηδενικός. Οι 

ιδιότητες που εμφανίζονται στις εξισώσεις μεταφοράς καθορίζονται από την παρουσία της 

σύστασης της φάσης σε κάθε όγκο ελέγχου. Σε ένα διφασικό σύστημα για παράδειγμα, αν οι 

φάσεις παριστάνονται από τους δείκτες (1) και (2) και αν παρακολουθείται το κλάσμα όγκου της 

δεύτερης φάσης, η πυκνότητα του κάθε κελιού δίνεται από την εξίσωση: 

 2 2 2 1(1 )      
  2-8 

Γενικότερα, για ένα σύστημα Ν-φάσεων, το κλάσμα όγκου κατά μέσο όρο πυκνότητας είναι 

της μορφής: 

 
k k  

  
2-9

 

Όλες οι άλλες ιδιότητες υπολογίζονται με αυτόν τον τρόπο (ιξώδες και θερμική 

αγωγιμότητα, για παράδειγμα) με την εξαίρεση της ειδικής θερμότητας, η οποία είναι το κλάσμα 

μάζας κατά μέσο όρο: 

 

kk k p

p

k k

c

c

 

 





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2.2.3 Η Εξίσωση ορμής 

Η εξίσωση ορμής επιλύεται σε όλο το χωρίο και το πεδίο ταχύτητας που προκύπτει και 

διαμοιράζεται μεταξύ των φάσεων. Η εξίσωση ορμής, όπως φαίνεται παρακάτω, είναι 

εξαρτημένη από το κλάσμα όγκου της kth φάσης, καθώς και από τις ιδιότητες της πυκνότητας 

και του ιξώδους. 

ji
j i j j j

i j i j i

uuP
u u u g F

t x x x x x
   

    
                  

2-11

 

Υπάρχει μόνο ένας περιορισμός σε περιπτώσεις, όπου υπάρχουν μεγάλες διαφορές των 

τιμών της ταχύτητας ανάμεσα στις φάσεις, η ακρίβεια των τιμών των ταχυτήτων, που 

υπολογίζονται κοντά στη διεπιφάνεια μπορεί να επηρεαστεί αρνητικά. 
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2.2.4 Η Εξίσωση Ενθαλπίας 

Η εξίσωση ενθαλπίας επίσης διαμοιράζεται ανάμεσα στις φάσεις και φαίνεται παρακάτω: 

 

i h

i i i

T
h u h k S

t x x x
 

    
   

          
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Οι ιδιότητες ρ και k διαμοιράζονται από τις φάσεις, όπως συζητήθηκε νωρίτερα. Ο όρος 

πηγής Sh, περιέχει συνεισφορές από ακτινοβολία και από θερμότητα αντίδρασης στην κύρια 

φάση αν οι αντιδράσεις είναι μέρος του μοντέλου. Όπως με το πεδίο ταχύτητας, η ακρίβεια της 

ενθαλπίας και κατά συνέπεια η θερμοκρασία κοντά στη διεπιφάνεια είναι περιορισμένη σε 

περιπτώσεις, όπου μεγάλες διαφορές της θερμοκρασίας υπάρχουν ανάμεσα στις φάσεις. 

2.2.5 Παρεμβολή κοντά στη διεπιφάνεια 

Η διατύπωση του όγκου ελέγχου απαιτεί ότι οι ροές της συναγωγής και διάχυσης 

διαμέσου των επιφανειών του όγκου ελέγχου υπολογίζονται και ισορροπούνται με τον όρο 

πηγής μέσα στον όγκο ελέγχου. Υπάρχουν δύο επιλογές στο FLUENT για τον υπολογισμό των 

ροών του μετώπου για το μοντέλο του όγκου ρευστού. Στην προεπιλεγμένη μέθοδο, η οποία 

είναι μία ρητή προσέγγιση και χρησιμοποιείται στην παρούσα εργασία, το πρότυπο σχήμα 

παρεμβολής περιέχει ροές του μετώπου οποτεδήποτε ένα κελί είναι απόλυτα γεμάτο με μία ή την 

άλλη φάση. Όταν το κελί είναι κοντά στη διεπιφάνεια των δύο φάσεων, ένα «δότη– αποδέκτη» 

(donor–acceptor) σχήμα χρησιμοποιείται για να καθοριστεί η ποσότητα ρευστού που 

μεταφέρεται μέσω του μετώπου. Αυτό το σχήμα αναγνωρίζει ένα κελί ως δότη μίας ποσότητας 

ρευστού από τη μία φάση και ένα άλλο (γειτονικό) κελί ως το δέκτη της ίδιας ποσότητας 

ρευστού και χρησιμοποιείται  για την αποτροπή της αριθμητικής διάχυσης στη διεπιφάνεια. Η 

ποσότητα ρευστού που μπορεί να μεταφερθεί είναι περιορισμένη από το ελάχιστο των δύο 

τιμών: στο κελί δότη, το οποίο είναι γεμάτο από τη μία φάση ή στο κελί δέκτη, το οποίο είναι 

άδειο από τη μία φάση. Χρησιμοποιήθηκε το συγκεκριμένο σχήμα καθώς είναι σημαντική η 

ακρίβεια της VOF λύσης με την πάροδο του χρόνου. Είναι ενδιαφέρον η χρονική εξάρτηση της 

λύσης με την ακρίβεια του χρόνου της μεταβατικής. 

2.2.6 Εξάρτηση από το χρόνο 

Η προεπιλεγμένη διατύπωση VOF στο Fluent εξαρτάται από το χρόνο, έτσι η εξίσωση 

k

k k
j

i

u S
t x



  
 

 
 λύνεται χρησιμοποιώντας ένα ρητό με το χρόνο σχήμα. Χρησιμοποιήσεις ένα 

χρονικό βήμα κάθε φορά για τον υπολογισμό όλων των εξισώσεων μεταφοράς. 

2.2.7 Προσδιορισμός των φάσεων 

Το επόμενο βήμα στην κατάστρωση του προβλήματος είναι η ονομασία των φάσεων. 

Είναι πολύ σημαντικό να οριστούν σωστά οι φάσεις καθώς επηρεάζεται σημαντικά η λύση. Στην 

παρούσα εργασία ως κύρια φάση ορίζεται ο αέρας (ιδανικό αέριο) και ως δευτερεύουσα φάση το 

νερό. Αυτό γίνεται καθώς θα χρησιμοποιηθεί ο νόμος των αερίων, ο οποίος και χρησιμοποιείται 

μόνο στην κύρια φάση. Συνεπώς το πυκνότερο ρευστό είναι το νερό. Αυτό σημαίνει ότι η 

εξίσωση κλάσματος όγκου θα λυθεί για το πυκνότερο ρευστό. Αν κατά τη διάρκεια της πορείας 

της λύσης, μικρές διαταραχές στο πεδίο των πιέσεων συμβαίνουν κοντά στη διεπιφάνεια, αυτές 



13 

 

μπορούν να μεταφραστούν σε διαταραχές στο πεδίο των ταχυτήτων. Εξαιτίας της αυξημένης 

αδράνειας, οι διαταραχές της ταχύτητας είναι μικρότερες πολύ λιγότερο αποσταθεροποιητικές 

στο πυκνότερο ρευστό σε σχέση με το λιγότερο πυκνό ρευστό. Αν το κλάσμα όγκου 

υπολογίζεται  για το πυκνότερο ρευστό, η αυξημένη σταθερότητα του πεδίου ταχυτήτων  οδηγεί 

σε αυξημένη σταθερότητα στον υπολογισμό του κλάσματος όγκου. 

2.2.8 Μέγιστος αριθμός courant για τη μέθοδο όγκου ρευστού 

Ο αριθμός Courant είναι ένας αδιάστατος αριθμός, ο οποίος συγκρίνει το χρονικό βήμα 

σε έναν υπολογισμό με το χαρακτηριστικό χρόνο διέλευσης ενός ρευστού στοιχείου σε έναν 

όγκο ελέγχου: 

 
/cell fluid

t

x u




 

Στην περιοχή κοντά στη διεπιφάνεια του ρευστού, το Fluent διαιρεί τον όγκο του κάθε 

κελιού με το άθροισμα των εξερχόμενων ροών (fluxes). Ο χρόνος που προκύπτει 

αντιπροσωπεύει το χρόνο που θα χρειαζόταν το ρευστό για να αδειάσει το κελί στο οποίο 

βρίσκεται. Ο μικρότερος χρόνος χρησιμοποιείται ως ο χαρακτηριστικός χρόνος διέλευσης ενός 

ρευστού στοιχείου σε έναν όγκο ελέγχου, όπως περιγράφεται παραπάνω. Βασιζόμενοι στο χρόνο 

και στα δεδομένα για το μέγιστο επιτρεπόμενο αριθμό Courant, υπολογίζεται ένα χρονικό βήμα 

για τη χρησιμοποίησή του στον υπολογισμό VOF. Για παράδειγμα, αν ο μέγιστος επιτρεπόμενος 

αριθμός Courant είναι 0.25, το χρονικό βήμα θα πρέπει να επιλεγεί να είναι το πολύ το ένα 

τέταρτο (1/4) του ελάχιστου χρόνου διέλευσης για οποιοδήποτε κελί κοντά στη διεπιφάνεια. 

2.2.9 Θέτοντας Συνοριακές συνθήκες 

Μια συνοριακή συνθήκη πρέπει να οριστεί, αφού είναι ενεργοποιημένο το VOF μοντέλο. 

Στο συγκεκριμένο διφασικό σύστημα, όπου η κύρια φάση είναι ο αέρας και η δεύτερη φάση 

είναι το νερό, τέθηκαν οι τρεις συνοριακές συνθήκες: 

 Η πίεση στα άκρα του χωρίου:  1 cosAtm fP P t    . 

 Η αξονοσυμμετρία της φυσαλίδας. 

 Το στερεό τοίχωμα. 

2.2.10 Το μοντέλο της επιφανειακής τάσης 

Είναι δυνατό να συμπεριληφθούν τα αποτελέσματα της επιφανειακής τάσης κατά μήκος 

της διεπιφάνειας ανάμεσα στα δύο ρευστά. Η επιφανειακή τάση προκύπτει σαν αποτέλεσμα των 

ελκτικών δυνάμεων ανάμεσα στα μόρια ενός ρευστού. Εάν θεωρηθεί μία φυσαλίδα αέρα μέσα 

σε νερό, τότε εντός της φυσαλίδας, η καθαρή δύναμη σε ένα μόριο λόγω των γειτονικών του 

μορίων είναι μηδέν. Στη διεπιφάνεια, ωστόσο η καθαρή δύναμη είναι ακτινικά προς τα μέσα 

λόγω της μεγαλύτερης πίεσης που ασκείται από το ρευστό που καταλαμβάνει τα κοίλα της 

επιφάνειας. Σαν αποτέλεσμα, προκειμένου να εξισορροπηθεί η συνδυασμένη επίδραση των 

ακτινικών δυνάμεων από τις δύο πλευρές του ρευστού σε όλη τη διεπιφάνεια, η τελευταία 

καμπυλώνει. Η επιφανειακή τάση είναι μία δύναμη, η οποία ενεργεί μόνο στη διεπιφάνεια και η 

οποία απαιτείται για να εξισορροπεί τις δυνάμεις πίεσης από τις δύο πλευρές της διεπιφάνειας . 
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Το μοντέλο της επιφανειακής τάσης στο FLUENT είναι η συνεχής επιφανειακή δύναμη 

(Continuum surface force CSF) μοντέλο, το οποίο προτείνεται και από προηγούμενη μελέτη 

[14]. Θεωρείται ότι, η πτώση πίεσης σε όλη την επιφάνεια εξαρτάται από τον συντελεστή 

επιφανειακής τάσης, σ και η επιφανειακή καμπυλότητα υπολογίζεται από τις δύο ακτίνες R1 και 

R2 σε ορθογωνική κατεύθυνση: 

 
2 1

1 2

1 1
( )P P
R R

  

 

Όπου p1 και p2 είναι οι πιέσεις στα δύο ρευστά στη μια και στην άλλη πλευρά της 

διεπιφάνειας. 
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3. Αριθμητική Ανάλυση 

Σε αυτήν την ενότητα επιχειρείται να δοθεί μία σύντομη περιγραφή της 

διαδικασίας επίλυσης που χρησιμοποιεί το υπολογιστικό πακέτο Fluent. 

3.1 Ο βασισμένος στην πίεση επιλυτής (Pressure-based solver) 

Ο βασισμένος στην πίεση επιλυτής απασχολεί έναν αλγόριθμο, ο οποίος ανήκει 

σε μία γενική τάξη μεθόδων οι οποίες ονομάζονται μέθοδος προβολής (the projection 

method) [15]. Σε αυτή τη μέθοδο, ο περιορισμός της διατήρησης της μάζας του πεδίου 

ταχύτητας επιτυγχάνεται με την επίλυση της εξίσωσης πίεσης. Η εξίσωση πίεσης 

προέρχεται από τις εξισώσεις συνέχειας και ορμής με τέτοιο τρόπο, ώστε το πεδίο 

ταχύτητας να διορθώνεται από την πίεση, ικανοποιώντας τη συνέχεια. Αφού οι 

κυρίαρχες εξισώσεις είναι μη γραμμικές και συνδυάζονται μεταξύ τους, η διαδικασία 

της λύση περιλαμβάνει επαναλήψεις, όπου όλο το σετ των κυρίαρχων εξισώσεων 

λύνεται επανειλημμένα μέχρι να συγκλίνει η λύση. 

3.1.1 Ο αποζευγμένος αλγόριθμος του επιλυτή βασισμένου στην πίεση 

Ο βασισμένος στην πίεση επιλυτής χρησιμοποιεί έναν αλγόριθμο για τη λύση, 

όπου οι κυρίαρχες εξισώσεις λύνονται ξεχωριστά. Επειδή οι κυρίαρχες εξισώσεις είναι 

μη γραμμικές και συζευγμένες, ο βρόχος της λύσης πρέπει να γίνεται επαναληπτικά 

προκειμένου να ληφθεί μία συγκλίνουσα αριθμητική λύση. Σε αυτόν τον αλγόριθμο, οι 

ατομικές κυρίαρχες εξισώσεις για τις μεταβλητές που λύνονται, λύνονται η μία μετά 

την άλλη. 

Στον αποζευγμένο αλγόριθμο, οι ατομικές κυρίαρχες εξισώσεις για τη λύση 

των μεταβλητών (για παράδειγμα u,v,w,p,T,k,ε) λύνονται η μία μετά την άλλη. Κάθε 

κυρίαρχη εξίσωση, ενώ λύνεται, διαχωρίζεται από τις άλλες εξισώσεις, από όπου 

προέρχεται και το όνομα του αλγορίθμου. Ο αποζευγμένος αλγόριθμος είναι πολύ 

αποδοτικός όσον αφορά τη μνήμη, καθώς οι διακριτοποιημένες εξισώσεις είναι 

αναγκαίο να αποθηκευτούν στη μνήμη μόνο μία φορά. Έτσι, η λύση συγκλίνει σχετικά 

αργά, αφού οι εξισώσεις λύνονται με ξεχωριστό τρόπο. 

Με τον αποζευγμένο αλγόριθμο, κάθε επανάληψη αποτελείται από τα βήματα που 

φαίνονται στο Σχήμα 3-1 και περιγράφονται παρακάτω: 

1. Ενημερώνονται οι ιδιότητες του ρευστού (για παράδειγμα, πυκνότητα, ιξώδες, 

ειδική θερμότητα). 

2. Λύνονται οι εξισώσεις ορμής, η μία μετά την άλλη, χρησιμοποιώντας τις 

πρόσφατα ενημερωμένες τιμές της πίεσης και των μαζικών ροών των 

μετώπων. 

3. Λύνει τη διόρθωση πίεσης εξίσωση χρησιμοποιώντας το πρόσφατο πεδίο 

ταχύτητας και μαζικής ροής. 

4. Διορθώνει τα τις μαζικές ροές στα μέτωπα, πίεση και πεδίο ταχύτητας 

χρησιμοποιώντας τη διόρθωση πίεσης από το βήμα 3. 

5. Λύνει τις εξισώσεις των επιπλέον βαθμωτών μεταβλητών όπως, ακτινοβολία 

ενέργεια, χρησιμοποιώντας τις τιμές των λύσεων των μεταβλητών. 



16 

 

6. Ενημερώνει τους όρους πηγής που προκύπτουν από τις αλληλεπιδράσεις 

ανάμεσα στις διαφορετικές φάσεις. 

7. Ελέγχει για σύγκλιση των εξισώσεων. 

Αυτά τα βήματα συνεχίζονται μέχρι τα κριτήρια σύγκλισης συναντηθούν. 

 
Σχήμα 3-1: Η διαδικασία σύγκλισης του αλγορίθμου που χρησιμοποιείται 

3.2 Γενική βαθμωτή εξίσωση μεταφοράς: Διακριτοποιήση και Λύση 

Το ANSYS FLUENT χρησιμοποιεί μια τεχνική βασισμένη στον όγκο ελέγχου 

για να μετατρέψει μία γενική εξίσωση μεταφοράς σε μία αλγεβρική εξίσωση, ώστε να 

μπορεί να λυθεί αριθμητικά. Αυτή η τεχνική αποτελεί την ενσωμάτωση της εξίσωσης 

μεταφοράς σε κάθε όγκο ελέγχου, αποδίδοντας μια διακριτή εξίσωση που εκφράζει το 

νόμο της διατήρησης με βάση τον όγκο ελέγχου. 

Η διακριτοποίηση των κυρίαρχων εξισώσεων μπορεί να απεικονιστεί εύκολα 

λαμβάνοντας υπόψη τη μεταβατική εξίσωση διατήρησης για τη μεταφορά μιας 

κλιμακωτής ποσότητα φ. Αυτό αποδεικνύεται από την ακόλουθη εξίσωση γραμμένη 

σε ολοκληρωτική μορφή για έναν αυθαίρετο όγκο ελέγχου V: 
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Και με διαφορική μορφή, θεωρώντας ασυμπίεστη ροή μπορεί να γραφεί: 

 
dV v V V S V

t
 


  


      
  

3-2
 

Η παραπάνω εξίσωση σε διαφορική μορφή, θεωρώντας ασυμπίεστη ροή και 

σταθερό ιξώδες μπορεί να γραφεί: 

2  
dV

V V P V
dt

            3-3 

Με σκοπό να γίνει ταύτιση της εξίσωσης του προβλήματος με αυτή που 

χρησιμοποιεί ο επιλυτής. 

Η παραπάνω εξίσωση εφαρμόζεται σε κάθε όγκο ελέγχου, ή κελί, στο 

υπολογιστικό χωρίο. Παρακάτω φαίνεται ένα παράδειγμα για το πώς εφαρμόζεται ο 

όγκος ελέγχου: 

 
Σχήμα 3-2: Ο όγκος ελέγχου που χρησιμοποιείται για την απείκονιση της διακριτοποίησης της 

βαθμωτής εξίσωσης μεταφοράς. 

Η διακριτοποίηση της πρώτης εξίσωσης γίνεται ως εξής: 
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Όπου το V
t




ορίζεται στη χρονική διακριτοποίηση. 

3.2.1 Λύνοντας το γραμμικό σύστημα 

Οι διακριτοποιημένες βαθμωτές εξισώσεις περιέχουν μία άγνωστη βαθμωτή 

μεταβλητή φ στο κέντρο του κελιού καθώς οι άγνωστες τιμές βρίσκονται στα γύρω 

γειτονικά κελιά. Αυτή η εξίσωση θα είναι γενικά μη γραμμική σε σχέση με αυτές τις 

μεταβλητές. Μία γραμμική μορφή αυτής της εξίσωσης μπορεί να γραφτεί: 

 
P nb nb

nb

a a b  
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,όπου το nb αναφέρεται στα γειτονικά κελιά και αP και αnb είναι οι γραμμικοί 

συντελεστές για το φ και φnb. 

Ο αριθμός των γειτονικών κελιών για κάθε κελί εξαρτάται από την τοπολογία του 

πλέγματος, αλλά τυπικά είναι ίσος με τον αριθμό των μετώπων που περιεκλείουν ένα 

κελί. 

3.3 Διακριτοποιήση 

3.3.1 Χωρική διακριτοποιήση 

Το ANSYS Fluent αποθηκεύει διακριτές τιμές της βαθμωτής ποσότητας φ στα 

κέντρα των κελιών. Έτσι οι τιμές των μετώπων φf απαιτούνται για τους όρους 

μεταφοράς στην εξίσωση 3−4 και πρέπει να γίνει παρεμβολή με τις τιμές στα κέντρα 

των κελιών. Αυτό επιτυγχάνεται χρησιμοποιώντας ένα ανάντη σχήμα. 

Το συγκεκριμένο σχήμα σημαίνει ότι η τιμή του μετώπου φf προέρχεται από 

ποσότητες στο ανάντη του κελιού συσχετιζόμενο με τη διεύθυνση της κανονικής 

ταχύτητας vn στην εξίσωση 3−4. Το ANSYS Fluent επιτρέπει να διαλέξει κάποιος 

ανάμεσα σε πολλά τέτοια σχήματα, όπως το πρώτης τάξης ανάντη σχήμα, το δεύτερης 

τάξης ανάντη σχήμα, power law, QUICK. Στη συγκεκριμένη εργασία περιγράφεται το 

δεύτερης τάξης, το οποίο και χρησιμοποιήθηκε. Οι όροι διάχυσης στην εξίσωση 3−4 

είναι με κεντρικές διαφορές και πάντα έχουν δεύτερης τάξης ακρίβεια. Με τη δεύτερης 

τάξης ακρίβεια, οι ποσότητες στα μέτωπα των κελιών υπολογίζονται χρησιμοποιώντας 
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μια πολυδιάστατη γραμμικής ανακατασκευής προσέγγιση [16]. Σε αυτή την 

προσέγγιση, η μεγάλης τάξης ακρίβεια επιτυγχάνεται στα μέτωπα του κελιού δια μέσω 

μιας επέκτασης της σειράς Taylor της κεντροειδής λύσης του κελιού. Έτσι όταν 

επιλέγεται το δεύτερης τάξης σχήμα, η τιμή του φf υπολογίζεται χρησιμοποιώντας την 

ακόλουθη σχέση: 

 f r    
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,όπου   και   είναι η τιμή στο κέντρο του κελιού και η κλίση του, και r  είναι 

το διάνυσμα μετατόπισης από το κέντρο του κελιού στο μέτωπο. Αυτή η μορφοποίηση 

απαιτεί τον προσδιορισμό της κλίσης   σε κάθε κελί, όπως θα συζητηθεί παρακάτω. 

Το σύστημα αυτό δεύτερης τάξης μπορεί να γραφεί σαν πρώτης τάξης σχήμα 

καθώς και επιπλέον όροι για το σχήμα ανώτερης τάξης. Η ανώτερης τάξης χαλάρωση 

μπορεί να εφαρμοστεί σε αυτούς τους επιπρόσθετους όρους. Η υποχαλάρωση των 

ανώτερης τάξης όρων ακολουθεί την κανονική μορφοποίηση για κάθε μεταβλητή : 

 int( )new old ermediate oldf     
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,όπου f  είναι ο παράγοντας υποχαλάρωσης. Στη συγκεκριμένη περίπτωση, όπου 

χρησιμοποιήθηκε παροδική περίπτωση είναι 0.75. Αυτός ο παράγοντας εφαρμόζεται 

σε όλες τις εξισώσεις που λύνονται. 

3.3.2 Χρονική Διακριτοποίηση 

Για παροδικές προσομοιώσεις, οι κυρίαρχες εξισώσεις πρέπει να 

διακριτοποιηθούν και στο χώρο, αλλά και στο χρόνο. Η χωρική διακριτοποίηση για 

εξισώσεις εξαρτημένες από το χρόνο είναι ίδια και με τις περιπτώσεις όπου ο χρόνος 

είναι σταθερός. Η χρονική διακριτοποίηση περιλαμβάνει την ολοκλήρωση του κάθε 

όρου στις διαφορικές εξισώσεις σε ένα χρονικό βήμα t . Η ολοκλήρωση των 

παροδικών όρων είναι απλή, όπως φαίνεται παρακάτω. Η γενική έκφραση για την 

εξέλιξη του χρόνου της μεταβλητής   δίνεται από: 

 
( )F

t







  
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, όπου η συνάρτηση F  ενσωματώνει κάθε χωρική διακριτοποίηση. Αν η 

παράγωγος του χρόνου διακριτοποιηθεί χρησιμοποιώντας κατάντι διαφορές, η πρώτης 

τάξης ακρίβεια χρονικής διακριτοποίησης δίνεται από: 
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και της δεύτερης τάξης διακριτοποίηση δίνεται από: 
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Στην παρούσα εργασία χρησιμοποιείται πρώτης τάξης άρρητη παροδική 

μορφοποίηση. Στη μέθοδο αυτή γίνεται εκτίμηση της ( )F   στο μελλοντικό επίπεδο 

του χρόνου: 
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Αυτό αναφέρεται ως άρρητη ολοκλήρωση μέχρι το 1n   σε ένα δεδομένο κελί και 

σχετίζεται με τα 1n   των γειτονικών κελιών δια μέσω του 1( )nF   : 

 
1 1( )n n ntF      3-12 

Αυτή η άρρητη εξίσωση μπορεί να λυθεί επαναληπτικά σε κάθε επίπεδο του 

χρόνου προτού πάει στο επόμενο χρονικό βήμα. Το πλεονέκτημα του πλήρως άρρητου 

σχήματος είναι ότι είναι άνευ όρων σταθερό σε σχέση με το μέγεθος του χρονικού 

βήματος. 

3.3.3 Εκτίμηση των κλίσεων και των παραγώγων. 

Οι κλίσεις δεν χρειάζονται μόνο για την κατασκευή τιμών ενός βαθμωτού στα 

μέτωπα των κελιών, αλλά επίσης και για τον υπολογισμό δευτεροβάθμιων όρων 

διάχυσης και κλίσεων ταχύτητας. Η κλίση   μιας δεδομένης μεταβλητής   

χρησιμοποιείται για να διακριτοποιήσει τους όρους μεταφοράς και διάχυσης στις 

εξισώσεις διατήρησης ροής. Οι κλίσεις στο ANSYS Fluent υπολογίζονται σύμφωνα με 

τις ακόλουθες μεθόδους: 

 Green-Gauss Cell-Based 

 Green-Gauss Node-Based 

 Least Squares Cell-Based (Μέθοδος ελαχίστων τετραγώνων) 

Στην παρούσα εργασία ο υπολογισμός των κλίσεων έγινε με την μέθοδο των 

ελαχίστων τετραγώνων, η οποία και περιγράφεται παρακάτω. Σε αυτή τη μέθοδο 

υποτίθεται ότι η λύση μεταβάλλεται γραμμικά. Στο παρακάτω σχήμα, η αλλαγή στις 

τιμές του κελιού μεταξύ του 0c  και του ic  κατά μήκος του φορέα ir  από το κέντρο 

βάρους του κελιού 0c στο κελί ic  μπορεί να εκφραστεί ως: 
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 0 0
( ) ( )

ic i c cr     
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Σχήμα 3-3: Εκτίμηση του Cell Centroid 

Αν γραφτούν τώρα παρόμοιες εξισώσεις για κάθε κελί γύρω από το κελί 0c , θα 

δημιουργηθεί το ακόλουθο σύστημα, το οποίο γράφεται σε σύντομη μορφή: 

 
 

0
( )cJ    
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, όπου  J είναι ο πίνακας συντελεστών, που είναι καθαρά συνάρτηση της 

γεωμετρίας. 

Ο στόχος εδώ είναι να καθοριστεί η κλίση του κελιού 0
ˆˆ ˆ( )x y zi j k        

λύνοντας το πρόβλημα ελαχιστοποίησης για το σύστημα του μη τετραγωνικού πίνακα 

συντελεστών. 

Το παραπάνω γραμμικό σύστημα της εξίσωσης είναι υπερορισμένο και μπορεί να 

λυθεί αναλύοντας τον συντελεστή του πίνακα χρησιμοποιώντας τη διαδικασία Gram-

Schmidt [17]. Αυτή η ανάλυση αποδίδει ένα πίνακα από βάρη σε κάθε κελί. Με τη 

διαδικασία αυτή, γίνεται μια εύκολη προεπεξεργασία και αποθήκευση των βαρών, έτσι 

ώστε οι κλίσεις σε κάθε κόμβο να μπορεί να υπολογιστεί κάνοντας επαναληπτική 

διαδικασία σε όλες τις πλευρές στο πλέγμα και κατανέμουν τη συμβολή της κάθε 

πλευράς σε κάθε κόμβο. Έτσι για το συγκεκριμένο σχήμα σημαίνει ότι οι τρεις 

συνιστώσες των βαρών 
0 0 0

( , , )x y z

i i iW W W  παράγονται για καθένα από τα μέτωπα του 

κελιού 0c . Επομένως η κλίση στο κέντρο του κελιού μπορεί τότε να υπολογιστεί με 

τον πολλαπλασιασμό των συντελεστών βάρους με το διάνυσμα διαφοράς 

1 0
( )c c     , 
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, όπου το άθροισμα είναι από όλα τα άκρα τα οποία συνδέονται με τον κόμβο, 

όπως στο παραπάνω σχήμα και τα βάρη δίνονται από 
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3.4 Χαρακτηριστικά του επιλυτή βασισμένου στην πίεση 

Παρακάτω περιγράφεται πως γίνεται η διακριτοποίηση των εξισώσεων ορμής 

και συνέχειας και λύση τους μέσω του επιλυτή βασισμένου στην πίεση. Η σταθερή 

εξίσωση συνέχειας και ορμής σε ολοκληρωτική μορφή είναι: 

 0v dA    3-17 

 

V

vv dA pI dA dA FdV            3-18 

,όπου I  είναι ο ταυτοτικός πίνακας,   είναι ο τανυστής των τάσεων και F  είναι 

το διάνυσμα της δύναμης. 

3.4.1 Διακριτοποιηση της εξίσωσης ορμής 

Το σχήμα διακριτοποίησης που περιγράφτηκε παραπάνω για μια βαθμωτή 

εξίσωση μεταφοράς χρησιμοποιείται επίσης και για τις εξισώσεις ορμής. Για 

παράδειγμα, στην x-κατεύθυνση εξίσωση, θέτοντας όπου u   γίνεται: 

 

ˆ
P nb nb f

nb

u u p A i S     
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Αν είναι γνωστά το πεδίο πίεσης και τα μέτωπα μαζικής ροής, από την παραπάνω 

εξίσωση μπορεί να λυθεί με τον ίδιο τρόπο που αναφέρθηκε στη διακριτοποίηση και 
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έτσι λαμβάνεται το πεδίο ταχύτητας. Έτσι, το πεδίο πίεσης και τα μέτωπα μαζικής 

ροής δεν είναι γνωστά εκ των προτέρων (a priori) και πρέπει να λαμβάνονται ως 

κομμάτι της λύσης. 

3.4.2 Σχήματα με παρεμβολή της πίεσης 

Tο προεπιλεγμένο σχήμα στο ANSYS Fluent παρεμβάλει τις τιμές της πίεσης στα 

faces χρησιμοποιώντας συντελεστές εξισώσεων ορμής [18]. 
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Επειδή δεν μπορεί να γίνει το κλασικό σχήμα παρεμβολής για την πίεση θα 

χρησιμοποιηθεί η επιλογή μετατόπισης πίεσης ή PRESTO (PREssure Staggering 

Option). Αυτό το σχήμα χρησιμοποιεί τη διακριτή ισορροπία της συνέχειας για ένα 

μετατοπισμένο όγκο ελέγχου στο μέτωπο για να υπολογίσει την μετατοπισμένη πίεση. 

Αυτή η διαδικασία είναι ίδια με τα μετατοπισμένα σχήματα που χρησιμοποιούνται με 

δομημένα πλέγματα [19]. Σε ένα μετατοπισμένο πλέγμα οι δυσκολίες είναι πολλές, 

αλλά μπορούν να λυθούν καθώς δεν χρειάζεται να υπολογιστούν όλες οι μεταβλητές 

για το ίδια σημεία του πλέγματος. Μπορεί να απασχοληθεί διαφορετικό πλέγμα για 

κάθε εξαρτημένη μεταβλητή. Σε ένα μετατοπισμένο πλέγμα, οι συνιστώσες της 

ταχύτητας υπολογίζονται για κάθε σημείο το οποίο βρίσκεται στα μέτωπα των όγκων 

ελέγχου. Έτσι η x-κατεύθυνση της ταχύτητας u είναι υπολογισμένη στα faces τα οποία 

είναι κανονικά στη x-κατεύθυνση. 

 
Σχήμα 3-4: Μετατοπισμένες θέσεις για u. 
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Οι θέσεις της u φαίνονται στο παραπάνω σχήμα με τα κοντά βελάκια, ενώ τα 

κεντρικά σημεία του πλέγματος είναι με μικρούς κύκλους. Οι διακεκομμένες γραμμές 

ορίζουν τους όγκους ελέγχου των μετώπων. Μπορεί να παρατηρηθεί ότι η u ταχύτητα 

μετατοπίζεται μόνο στην x-κατεύθυνση. Με άλλα λόγια, η θέση της u βρίσκεται 

μεταξύ δύο κύριων σημείων του πλέγματος. Η θέση της u πρέπει να βρίσκεται στο 

μέτωπο των όγκων ελέγχου. Είναι εύκολο να παρατηρηθεί στο παρακάτω σχήμα πως 

ορίζονται οι θέσεις των συνιστωσών της ταχύτητας u και w . 

 
Σχήμα 3-5: Μετατοπισμένες θέσεις για u και v 

Τα σημαντικά πλεονεκτήματα αυτής της μεθόδου είναι δύο. Για ένα τυπικό όγκο 

ελέγχου είναι εύκολο να παρατηρηθεί ότι η διακριτοποιημένη εξίσωση συνέχειας θα 

περιέχει τις διαφορές των γειτονικών στοιχείων της ταχύτητας και αυτό θα εμποδίσει 

ένα κυματώδες πεδίο ταχύτητας από την ικανοποίηση της εξίσωσης συνέχειας. Στο 

μετατοπισμένο πλέγμα μόνο τα λογικά πεδία ταχύτητας έχουν πιθανότητα να είναι 

αποδεκτά στην εξίσωση συνέχειας. Το δεύτερο σημαντικό πλεονέκτημα του 

μετατοπισμένου πλέγματος είναι ότι η διαφορά της πίεσης μεταξύ δύο γειτονικών 

σημείων του πλέγματος τώρα γίνεται η φυσική οδηγήτρια δύναμη για τις συνιστώσες 

της ταχύτητας μεταξύ αυτών των κύριων σημείων του πλέγματος. 

3.4.3 Διακριτοποίηση της εξίσωσης συνέχειας 

Η εξίσωση συνέχειας μπορεί να ολοκληρωθεί σε έναν όγκο ελέγχου, όπως σε 

αυτόν στο σχήμα Σχήμα 3-2. Οι όγκοι ελέγχου συνηθίζουν να απεικονίζουν τη 
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διακριτοποίηση της βαθμωτής εξίσωσης μεταφοράς για να παράξουν την ακόλουθη 

διακριτή εξίσωση: 

 

0
facesN

f f

f

J A 
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,όπου fJ  είναι το mass flux δια μέσω face f , 
nv . 

Στη συνέχεια, είναι απαραίτητο να συσχετισθεί οι τιμές της ταχύτητας στα faces, 

nv , με τις αποθηκευμένες τιμές της ταχύτητας στα κέντρα των κελιών. Επειδή η 

γραμμική παρεμβολή στις ταχύτητες των κέντρων των κελίων δεν βοηθάει, καθώς 

γίνεται αφύσικη εκτίμηση της πίεσης στα όρια των όγκων ελέγχου. Έτσι το ANSYS 

Fluent χρησιμοποιεί μια διαδικασία ίδια με αυτή που περιγράφεται από τους Rhie και 

Chow [18] για να εμποδίσει αύτη την κακή εκτίμηση. Η τιμή του μετώπου της 

ταχύτητας δεν προσεγγίζεται γραμμικά, αλλά χρησιμοποιώντας βεβαρυμμένους 

συντελεστές, βασισμένους στους P  συντελεστές από την εξίσωση  
3-19

. 

Χρησιμοποιώντας αυτή τη διαδικασία, η ροή μάζας στο μέτωπο, fJ , μπορεί να 

γραφτεί ως εξής: 
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,όπου 
0cp , 

1c
p και 

0 1, ,,n c n cv v  είναι οι πιέσεις και οι κάθετες ταχύτητες, αντίστοιχα, 

εντός των δύο κελιών εκατέρωθεν του μετώπου και 
fJ  περιέχει την επίδραση των 

ταχυτήτων σε αυτά τα κελιά. Ο όρος fd είναι μία συνάρτηση του p , της μέσης τιμής 

των συντελεστών P  της εξίσωσης ορμής για τα κελιά εκατέρωθεν του μετώπου f . 

3.4.4 Το άρρητο σχήμα βασισμένο στην πίεση και διαχωρισμό τελεστών (PISO) 

Στην παρούσα εργασία χρησιμοποιήθηκε η PISO μέθοδος για να υπάρχει 

καλύτερη εκτίμηση των αποτελεσμάτων. Παρακάτω περιγράφεται η μέθοδος αυτή, η 

οποία είναι τμήμα της οικογένειας των SIMPLE αλγόριθμων και βασίζεται στην 

καλύτερη προσέγγιση της σχέση μεταξύ των διορθώσεων για την πίεση και την 

ταχύτητα. Το κύριο χαρακτηριστικό της τεχνικής είναι η διαχωρισμός της διαδικασία 

λύσης σε μια σειρά βημάτων σύμφωνα με την οποία οι εργασίες σχετικά με την πίεση 

είναι αποσυνδεδεμένες από εκείνες που αφορούν την ταχύτητα σε κάθε βήμα. Όπως 

είναι γνωστό ο SIMPLE αλγόριθμος χρησιμοποιεί μια διόρθωση πίεσης και ταχύτητας. 

Όμως ένας από τους περιορισμούς είναι ότι οι νέες ταχύτητες και οι αντίστοιχες ροές 

δεν ικανοποιούν την εξίσωση συνέχειας μετά τη λύση της εξίσωσης διόρθωσης πίεσης. 

Αυτό έχει ως αποτέλεσμα, ότι ο υπολογισμός πρέπει να επαναλαμβάνεται μέχρι να 

ικανοποιείται η ισορροπία. Για να βελτιωθεί η απόδοση αυτού του υπολογισμού, ο 
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PISO αλγόριθμος εκτελεί δύο παραπάνω διορθώσεις, την διόρθωση ορμής (neighbor 

correction) και την διόρθωση λοξότητας (skewness correction). 

Διόρθωση ορμής (Neighbor correction) 

Η βασική ιδέα του αλγορίθμου PISO είναι να μετακινεί τους 

επαναλαμβανόμενους υπολογισμούς που απαιτούνται για την SIMPLE μέσα στη φάση 

της λύσης της εξίσωσης διόρθωσης πίεσης [20]. Μετά από μία η περισσότερες 

επαναλήψεις, οι διορθωμένες ταχύτητες ικανοποιούν τις εξισώσεις συνέχειας και 

ορμής ακόμα καλύτερα. Η επαναλαμβανόμενη αυτή διαδικασία ονομάζεται διόρθωση 

ορμής ή «neighbor correction». Ο αλγόριθμος PISO χρησιμοποιεί λίγη παραπάνω CPU 

χρόνο για κάθε επανάληψη, αλλά μπορεί δραματικά να μειώσει τον αριθμό των 

επαναλήψεων που απαιτούνται για την σύγκλιση. 

Διόρθωση Λοξότητας (Skewness correction) 

Για πλέγματα με κάποιο βαθμό λοξότητας, η προσεγγιστική σχέση μεταξύ της 

διόρθωσης της ροής μάζας στο μέτωπο του κελιού και η διαφορά της διόρθωσης της 

πίεσης στα γειτονικά κελιά είναι πολύ πρόχειρη. Έτσι οι συνιστώσες της κλίσης 

διόρθωσής πίεσης κατά μήκος των μετώπων του κελιού δεν είναι γνωστά εκ των 

προτέρων, οπότε χρησιμοποιείται μια επαναληπτική διαδικασία παρόμοια με την PISO 

διόρθωση ορμής που περιγράφτηκε παραπάνω [21]. Μετά την αρχική λύση της 

εξίσωσης διόρθωσης πίεσης, η κλίση της διόρθωσης πίεσης επαναϋπολογίζεται και 

χρησιμοποιείται για να ενημερώσει τις διορθώσεις της ροής μάζας. Αυτή η διαδικασία, 

μειώνει σημαντικά τις δυσκολίες σύγκλισης που σχετίζονται με παραμορφωμένα 

πλέγματα. 

Υποχαλάρωση για τη δότη-αποδέκτη μορφοποίηση εξαρτημένης από το χρόνο 

Στην παρούσα εργασία δεν έγινε καμία αλλαγή στους παράγοντες υποχαλάρωσης 

(underrelaxation) που χρησιμοποιήθηκαν. Με αυτόν τον τρόπο επιτρέπονται αυξημένες 

τιμές σε όλους τους παράγοντες υποχαλάρωσης, παρέχοντας ένα μικρό χρονικό βήμα, 

χωρίς απώλεια στην σταθερότητα της λύσης. 

3.4.5 Αναπροσαρμογή πλέγματος 

Για την βελτίωση των διαγραμμάτων, καθώς και των εικόνων, χρησιμοποιήθηκε 

στην παρούσα εργασία αναπροσαρμογή πλέγματος «grid adaption». Η 

αναπροσαρμογή πλέγματος έγινε με βάση την απόσταση από το στερεό τοίχωμα. 

Ουσιαστικά σε όποια κελιά χρειάζεται να γίνει πύκνωση για τη βελτίωση των 

αποτελεσμάτων, καθώς και από την αλληλεπίδραση των δύο ρευστών σε αυτές τις 

περιοχές, η υπολογιστική πλατφόρμα που χρησιμοποιήθηκε αυξάνει τον αριθμό των 

κελιών στη συγκεκριμένη περιοχή. Αυτή η διαδικασία δεν μπορεί να αυξήσει την 

ανάλυση της καμπύλης επιφάνειας, που στη συγκεκριμένη περίπτωση είναι η 

διεπιφάνεια φυσαλίδας ρευστού. Ως εκ τούτου, εάν τα περισσότερα κελιά που 

απαιτούνται σε μία καμπυλωμένη επιφάνεια είναι για την περιοχή όπου το σχήμα της 

παρουσιάζει σημαντική παραμόρφωση, δημιουργείται πλέγμα με επαρκείς κόμβους 

στην επιφάνεια ώστε να μεγαλώσει η ακρίβεια του επιλυτή. Τα παρακάτω σχήματα 
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Σχήμα 3-6 και Σχήμα 3-7 δείχνουν πως γίνεται η αναπροσαρμογή του πλέγματος 

κοντά σε μια συνοριακή συνθήκη. 

 

Σχήμα 3-6: Το πλέγμα πριν την αναπροσαρμογή. 

 

Σχήμα 3-7: Το πλέγμα μετά την αναπροσαρμογή. 

3.5 Benchmark Test 

3.5.1 Υπολογισμός χαρακτηριστικού χρόνου 

Στην τρέχουσα υποενότητα θα γίνει μία σύγκριση των αποτελεσμάτων του 

Fluent, για μηδενικό ιξώδες, με προηγούμενη μελέτη [9] καθώς και από κώδικα 

συνοριακών στοιχείων [22] με σκοπό να διαπιστωθεί η ορθότητα των αποτελεσμάτων. 

Υπολογίστηκε ο χαρακτηριστικός χρόνος για να μπορούν να μετατραπούν τα 

αδιάστατα μεγέθη που χρησιμοποιούνται στους κώδικες, στο FLUENT. Οπότε ο 

χαρακτηριστικός χρόνος υπολογίζεται ως εξής: 
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Επίσης:

0

2
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f f
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Αυτά είναι τα δεδομένα όταν 0.5   και απόσταση από τον τοίχο 

2 (2 )D mm ί ά ί ό έ ί           . 

Στις περιπτώσεις που έγιναν, χρησιμοποιήθηκε χρονικό βήμα της τάξεως του 10
-6

 

και ο αριθμός των κελιών της φυσαλίδας ήταν 336 2 672  . Ενώ όταν έγινε 

αναπροσαρμογή πλέγματος το χρονικό βήμα έγινε της τάξεως του 10
-7

 και ο αριθμός 

των κελιών της φυσαλίδας αυξήθηκε στα 1336 2 2672  . 

3.5.2  Αποτελέσματα προσομοιώσεων για  ε=0,2, ωf=959,4824 rad/s 

Ο χαρακτηριστικός χρόνος είναι: 

3
3 30.0036478 , 998.2 , 10 , 0.0075char

r
s kg m r m m


  




        

Όποτε στη παρούσα εργασία ο χρόνος μέχρι τον οποίο μπορεί να γίνει η σύγκριση 

είναι: 
3* ( ) 1.8 0.0036478 0.00656604 6.56604 10chart t ά T s s           

Από το σχήμα 1 προηγούμενης μελέτης [9] τα δεδομένα είναι: 

0

1 , 4 , 101325

0.2, 959,4824 / , 20526.31 /

st

f

r mm D mm P Pa

rad s rad s  

  

  
  

Τα διαγράμματα έγιναν με το πρόγραμμα OriginPro. Παρακάτω φαίνεται το 

διάγραμμα του κέντρου μάζας με την πάροδο του χρόνου μέσα από το συγκεκριμένο 

πρόγραμμα, καθώς και από το Fluent: 
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Διάγραμμα 3-1: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0.2 και ωf=959,4824 rad/s 

Το επόμενο διάγραμμα δείχνει πως μεταβάλλεται ο όγκος της φυσαλίδας 

σύμφωνα με το χρόνο: 
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Διάγραμμα 3-2: Μεταβολή του όγκου της φυσαλίδας για ε=0.2 και ωf=959,4824 rad/s. 

Ουσιαστικά είναι το διάγραμμα της ιδιοσυχνότητας της φυσαλίδας. Τα αντίστοιχα 

διαγράμματα από τους κώδικες συνοριακών στοιχείων [22] είναι: 
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Διάγραμμα 3-3: Μεταβολή του όγκου της φυσαλίδας για ε=0.2 και ωf=959,4824 rad/s 
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Διάγραμμα 3-4: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0.2 και ωf=959,4824 rad/s 

Είναι φανερό ότι συμπίπτουν τα διαγράμματα με τους χρόνους και τις τιμές 

ανάμεσα στην υπολογιστική πλατφόρμα Fluent και στους κώδικες συνοριακών 

στοιχείων μέσω της Fortran [22]. 

3.5.3  Αποτελέσματα προσομοιώσεων για ε=0,2, ωf=9457,7554 rad/s 

Από το σχήμα 2 προηγούμενης μελέτης [21] τα δεδομένα είναι: 

0

1 , 4 , 101325

0.2, 9457.7554 / , 20526.31 /

st

f

r mm D mm P Pa

rad s rad s  

  

  
 

Παρακάτω φαίνεται το διάγραμμα του κέντρου μάζας με την πάροδο του χρόνου: 
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Διάγραμμα 3-5: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0.2 και ωf=9457,7554 rad/s 
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Το επόμενο διάγραμμα δείχνει πως μεταβάλλεται ο όγκος της φυσαλίδας 

σύμφωνα με το χρόνο: 
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Διάγραμμα 3-6: Μεταβολή του όγκου της φυσαλίδας για ε=0.2 και ωf=9457,7554 rad/s 

Και τα αντίστοιχα διαγράμματα από κώδικες συνοριακών στοιχείων είναι [22]: 
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Διάγραμμα 3-7: Μεταβολή του όγκου της φυσαλίδας για ε=0.2 και ωf=9457,7554 rad/s 
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Διάγραμμα 3-8: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0.2 και ωf=9457,7554 rad/s 

Σε αυτήν την περίπτωση τα διαγράμματα του κέντρου μάζας συμπίπτουν και 

υπάρχουν κάποιες μικρές διαφορές στο διάγραμμα του όγκου της φυσαλίδας μετά την 

χρονική στιγμή 0.002 s. Εδώ που υπάρχει κάποια διαφορά, καλό θα ήταν να γίνουν 

προσομοιώσεις με καλύτερο πλέγμα, όπως περιγράφεται στην ενότητα 3.4.5 και 

καλύτερο χρονικό βήμα. 

Η παρακάτω εικόνα παρουσιάζει τις σημαντικότερες φάσεις της φυσαλίδας με 

βάση υπολογισμούς συνοριακών στοιχείων [22] 

για
40.2, 2, 40, 5 10 , 9457.7554fd ί ό ή            . Στο 

διδακτορικό [22] το d ορίζεται ως η απόσταση μεταξύ των φυσαλίδων μετρημένη με 

βάση τον αριθμό των διαμέτρων. Στην παρούσα περίπτωση η απόσταση από το 

τοίχωμα είναι 4mm, δηλαδή η διάμετρος της φυσαλίδας: 
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Εικόνα 3-1: Φάσεις της φυσαλίδας σε διαφορετικές χρονικές στιγμές 

 

 
Εικόνα 3-2: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-3: Η μέγιστη διαστολή της φυσαλίδας 

 

 
Εικόνα 3-4: Μικρή συστολή της φυσαλίδας 
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Εικόνα 3-5: Έντονη παραμόρφωση και μετακίνηση της φυσαλίδας 

 

 
Εικόνα 3-6: Συστολή, χαλαρή παραμόρφωση και μετακίνηση της φυσαλίδας 

Στις τρεις πρώτες εικόνες φαίνεται η πλήρης ταύτιση των εικόνων από τα 

συνοριακά στοιχεία με τις αντίστοιχες εικόνες μέσω του Fluent. Οι φάσεις και οι 

αντίστοιχες χρονικές στιγμές της φυσαλίδας ταιριάζουν απόλυτα. Μόνο στην τέταρτη 

περίπτωση υπάρχει μία καθυστέρηση στην μετακίνηση της φυσαλίδας της τάξης των 

10
-3

 s, σε σχέση με τους υπολογισμούς συνοριακών στοιχείων, ενώ παρατηρείται η 

ανάπτυξη αριθμητικών ασταθειών στο μπροστινό μέρος της φυσαλίδας. Είναι πιθανόν 

η ύπαρξη αριθμητικού σφάλματος κατά τη διακριτοποίησης της συγκεκριμένης 
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περιοχής της φυσαλίδας, ίσως στην διαδικασία αναπροσαρμογή πλέγματος, να 

δημιουργεί αυτή την γρηγορότερη εμφάνιση του φαινομένου καθώς και την 

εντονότερη παραμόρφωση της φυσαλίδας. 

3.5.4 Αποτελέσματα προσομοιώσεων για ε=0.5, ωf=959.4824 rad/s 

Εδώ παρατίθενται αποτελέσματα, τα οποία θα συγκριθούν μόνο με τους κώδικες 

συνοριακών στοιχείων, οι οποίοι έγιναν με προγραμματισμό στην Fortran [22]. Για την 

συγκεκριμένη περίπτωση, τα δεδομένα που χρησιμοποιήθηκαν είναι τα εξής: 
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0.5, 938 / , 20526.31 /

st
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r mm D mm P Pa

rad s rad s  

  
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Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας για την συγκεκριμένη περίπτωση από την προσομοίωση στην υπολογιστική 

πλατφόρμα Fluent: 
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Διάγραμμα 3-9: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 0.5 και ωf = 938rad/s 
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Διάγραμμα 3-10: Μεταβολή του όγκου της φυσαλίδας για ε= 0.5 και ωf = 938rad/s 

Και τα αντίστοιχα διαγράμματα από κώδικες συνοριακών στοιχείων είναι [22]: 
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Διάγραμμα 3-11: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 0.5 και ωf = 938rad/s 
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Διάγραμμα 3-12: Μεταβολή του όγκου της φυσαλίδας για ε= 0.5 και ωf = 938rad/s 

Σε αυτή την περίπτωση υπάρχει πλήρη ταύτιση των αποτελεσμάτων της 

υπολογιστικής πλατφόρμας με τους κώδικες συνοριακών στοιχείων [22]. Παρακάτω 

φαίνονται οι φωτογραφίες της φυσαλίδας σε διάφορες χρονικές στιγμές συγκρινόμενες 

και με τις αντίστοιχες χρονικές στιγμές από τους κώδικες συνοριακών στοιχείων [22]. 

Η παρακάτω εικόνα δημιουργήθηκε μέσω του προγράμματος MatLab [22] και 

παρουσιάζει τις σημαντικότερες φάσεις της φυσαλίδας για 

0.5, 1, 20, 0.001, 959.48fd ί ό ή           . Στο διδακτορικό 

[22] το d ορίζεται ως η απόσταση μεταξύ των φυσαλίδων μετρημένη με βάση τον 

αριθμό των διαμέτρων. Στην παρούσα περίπτωση η απόσταση από το τοίχωμα είναι 

2mm, δηλαδή η διάμετρος της φυσαλίδας. 
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Εικόνα 3-7: Φάσεις της φυσαλίδας σε διαφορετικές χρονικές στιγμές 

Οι αντίστοιχες εικόνες από την προσομοίωση μέσα από το υπολογιστικό πακέτο 

Fluent είναι οι εξής: 

 
Εικόνα 3-8: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-9: Συστολή και μετακίνηση της φυσαλίδας 

 
Εικόνα 3-10: Διαστολή και έντονη παραμόρφωση από τη δεξιά πλευρά 
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Εικόνα 3-11: Συστολή και μετακίνηση της φυσαλίδας με έντονη εσοχή (jet) 

3.5.5 Αποτελέσματα προσομοιώσεων για ε=2, ωf=959.4824 rad/s 

Σε αυτό το κομμάτι γίνεται παράθεση των αποτελεσμάτων, τα οποία θα 

συγκριθούν μόνο με τους κώδικες συνοριακών στοιχείων, οι οποίοι έγιναν με 

προγραμματισμό στην Fortran [22]. Για την συγκεκριμένη περίπτωση, τα δεδομένα 

που χρησιμοποιήθηκαν είναι τα εξής: 

0
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st

f

r mm D mm P Pa
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  

  
 

Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας για την συγκεκριμένη περίπτωση μέσα από την προσομοίωση στην 

υπολογιστική πλατφόρμα Fluent: 
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Διάγραμμα 3-13: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 2 και ωf = 989,4824 rad/s 
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Διάγραμμα 3-14: Μεταβολή του όγκου της φυσαλίδας για ε= 2 και ωf = 989,4824 rad/s 
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Και τα αντίστοιχα διαγράμματα από κώδικες συνοριακών στοιχείων [22] είναι: 
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Διάγραμμα 3-15: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 2 και ωf = 989,4824 rad/s 
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Διάγραμμα 3-16: Μεταβολή του όγκου της φυσαλίδας για ε= 2 και ωf = 989,4824 rad/s 

Η παρακάτω εικόνα παρουσιάζει τις σημαντικότερες φάσεις της φυσαλίδας όπως 

προκύπτουν από προσομοιώσεις συνοριακών στοιχείων [22] για τις ακόλουθες τιμές 

παραμέτρων, 2, 1, 20, 0.001, 959.48fd ί ό ή           . Στο 

διδακτορικό [22] το d ορίζεται ως η απόσταση μεταξύ των φυσαλίδων μετρημένη με 

βάση τον αριθμό των διαμέτρων. Στην παρούσα περίπτωση η απόσταση από το 

τοίχωμα είναι 2mm, δηλαδή η διάμετρος της φυσαλίδας. 
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Εικόνα 3-12: Φάσεις της φυσαλίδας σε διαφορετικές χρονικές στιγμές 

Οι αντίστοιχες εικόνες από την προσομοίωση μέσα από το υπολογιστικό πακέτο 

Fluent είναι οι εξής: 

 
Εικόνα 3-13: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-14: Συστολή και μετακίνηση της φυσαλίδας 

 
Εικόνα 3-15: Δημιουργία έντονης εσοχής στη δεξιά πλευρά της φυσαλίδας 

Αξίζει να σημειωθεί η εμφάνιση «jet» στις προσομοιώσεις με FLUENT στο σχήμα 

3.9.σε παρόμοια χρονική κλίμακα και με παρόμοια μορφή με τις προσομοιώσεις 

συνοριακών στοιχείων [22]. 

3.5.6 Αποτελέσματα προσομοιώσεων για ε=2, ωf=34894.74 rad/s 

Εδώ γίνεται παράθεση των αποτελεσμάτων, τα οποία θα συγκριθούν μόνο με τους 

κώδικες συνοριακών στοιχείων, οι οποίοι έγιναν με προγραμματισμό στην Fortran. Για 

την συγκεκριμένη περίπτωση, τα δεδομένα που χρησιμοποιήθηκαν είναι τα εξής: 
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Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας προσομοιώνοντας την συγκεκριμένη περίπτωση στην υπολογιστική 

πλατφόρμα Fluent: 
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Διάγραμμα 3-17: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 
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Διάγραμμα 3-18: Μεταβολή του όγκου της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 

Και τα αντίστοιχα διαγράμματα από κώδικες συνοριακών στοιχείων [22] είναι: 
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Διάγραμμα 3-19: Μεταβολή του όγκου της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 
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Διάγραμμα 3-20: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 

Η παρακάτω εικόνα παρουσιάζει τις σημαντικότερες φάσεις της φυσαλίδας με την 

μέθοδο συνοριακών στοιχείων [22], για τιμές παραμέτρων, 

2, 1, 40, 0.001, 34894.73fd ί ό ή           . Στο διδακτορικό 

[22] το d ορίζεται ως η απόσταση μεταξύ των φυσαλίδων μετρημένη με βάση τον 

αριθμό των διαμέτρων. Στην συγκεκριμένη περίπτωση η απόσταση από το τοίχωμα 

είναι 2mm, δηλαδή η διάμετρος της φυσαλίδας: 
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Εικόνα 3-16: Φάσεις της φυσαλίδας σε διαφορετικές χρονικές στιγμές 

Οι αντίστοιχες εικόνες από την προσομοίωση μέσα από το υπολογιστικό πακέτο 

Fluent είναι οι εξής: 

 
Εικόνα 3-17: Το αρχικό της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-18: Η μέγιστη διαστολή της φυσαλίδας. 

 
Εικόνα 3-19: Συστολή και μετακίνηση της φυσαλίδας με δημιουργία έντονης εσοχής (jet) 

Εδώ αξίζει να σημειωθεί η απόκλιση των προσομοιώσεων με το FLUENT, σε 

σχέση με τα συνοριακά στοιχεία [22], όσον αφορά την ακρίβεια υπολογισμού του 

σχήματος στο μπροστινό μέρος της φυσαλίδας όπου εμφανίζεται αριθμητική αστάθεια 

στον υπολογισμό του σχήματος. 

3.6 Αποτελέσματα με αναπροσαρμογή πλέγματος (grid adaption) 

Τα αποτελέσματα που θα παρουσιαστούν παρακάτω, έχουν γίνει με 

αναπροσαρμογή πλέγματος, καθώς και την προσθήκη του ιξώδους, ώστε να μπορεί να 
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γίνει μία μελέτη της επίδρασης που έχει στη συμπεριφορά της φυσαλίδας. Ουσιαστικά 

φαίνεται η οπτική βελτίωση των αποτελεσμάτων των εικόνων από τις παραπάνω 

υποενότητες 3.5.4 και 3.5.6. 

3.6.1 Αποτελέσματα με αναπροσαρμογή πλέγματος για ε=0.5, ωf=959,4824 rad/s 

Εδώ γίνεται παράθεση των αποτελεσμάτων, τα οποία θα συγκριθούν με τους 

κώδικες συνοριακών στοιχείων[22]. Τα συγκεκριμένα αποτελέσματα έχουν 

μεγαλύτερη ακρίβεια, καθώς έχει χρησιμοποιηθεί αναπροσαρμογή πλέγματος «grid 

adaption» Για την συγκεκριμένη περίπτωση, τα δεδομένα που χρησιμοποιήθηκαν είναι 

τα εξής: 

0
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st

f

r mm D mm P Pa

rad s rad s  

  

  
 

Παρακάτω φαίνεται το διάγραμμα του κέντρου μάζας με την πάροδο του χρόνου: 
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Διάγραμμα 3-21: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 0,5 και ωf =938 rad/s 

Το επόμενο διάγραμμα δείχνει πως μεταβάλλεται ο όγκος της φυσαλίδας 

σύμφωνα με το χρόνο: 
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Διάγραμμα 3-22: Μεταβολή του όγκου της φυσαλίδας για ε= 0,5 και ωf =938 rad/s 

Οι παρακάτω εικόνες παρουσιάζουν τις σημαντικότερες φάσεις της φυσαλίδας σε 

διαφορετικές χρονικές στιγμές. Για ε=0.5 η φυσαλίδα ξεκινάει να συστέλλεται μέχρι 

να φτάσει τη μέγιστη συστολή και έπειτα συνεχίζει να διαστέλλεται μέχρι τη μέγιστη 

διαστολή. Στη συνέχεια συστέλλεται και αρχίζει να μετακινείται προς το τοίχωμα και 

στην επόμενη χρονική στιγμή δημιουργείται μία έντονη εσοχή (jet) από τη δεξιά 

πλευρά. Ακολουθούν οι φωτογραφίες της φυσαλίδας: 

 

Εικόνα 3-20: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-21: Μέγιστη συστολή της φυσαλίδας 

 

Εικόνα 3-22: Μέγιστη διαστολή της φυσαλίδας 
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Εικόνα 3-23: Συστολή και μετακίνηση της φυσαλίδας προς το τοίχωμα 

 

Εικόνα 3-24: Δημιουργία έντονης εσοχής στη φυσαλίδα από τη δεξιά πλευρά 

 

3.6.2 Αποτελέσματα με αναπροσαρμογή πλέγματος για ε=2, ωf=34894,74 rad/s 

Παρακάτω παρατίθενται τα αποτελέσματα, τα οποία θα συγκριθούν με τους 

κώδικες συνοριακών στοιχείων. Τα συγκεκριμένα αποτελέσματα επίσης έχουν 

μεγαλύτερη ακρίβεια, καθώς έχει χρησιμοποιηθεί αναπροσαρμογή πλέγματος «grid 
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adaption» Για την συγκεκριμένη περίπτωση, τα δεδομένα που χρησιμοποιήθηκαν είναι 

τα εξής: 

0
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  
 

Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας από την προσομοίωση στην υπολογιστική πλατφόρμα Fluent: 
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Διάγραμμα 3-23: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 
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Διάγραμμα 3-24: Μεταβολή του όγκου της φυσαλίδας για ε= 2 και ωf =34894,74 rad/s 
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Αυτά τα αποτελέσματα με αναπροσαρμογή πλέγματος έχουν καλύτερη ανάλυση 

σε σχέση με τα διαγράμματα που δεν έχουν και συνάδουν στη διεξαγωγή καλύτερων 

αποτελεσμάτων. 

Οι παρακάτω εικόνες παρουσιάζουν τις σημαντικότερες φάσεις της φυσαλίδας σε 

διαφορετικές χρονικές στιγμές. Για ε=2 η φυσαλίδα ξεκινάει να συστέλλεται μέχρι να 

φτάσει τη μέγιστη συστολή και έπειτα συνεχίζει να διαστέλλεται μέχρι τη μέγιστη 

διαστολή. Στη συνέχεια συστέλλεται και αρχίζει να μετακινείται προς το τοίχωμα. 

Ακολουθούν οι φωτογραφίες της φυσαλίδας: 

 

 

 

 

 

Εικόνα 3-25: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 3-26: Μέγιστη συστολή της φυσαλίδας 

 

Εικόνα 3-27: Μέγιστη διαστολή της φυσαλίδας 
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Εικόνα 3-28: Συστολή και μετακίνηση της φυσαλίδας προς το τοίχωμα 

Ουσιαστικά είναι φανερό ότι η αναπροσαρμογή πλέγματος αποδίδει καλύτερα 

το σφαιρικό σχήμα στο μπροστινό μέρος της φυσαλίδας (spherical cup shape) 
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4. Αποτελέσματα προσομοιώσεων 

Από τις προσομοιώσεις που διεξήχθησαν με ιξώδες υπολογίζονται το κέντρο 

μάζας και ο όγκος της φυσαλίδας και χαράσσονται τα αντίστοιχα διαγράμματα. 

4.1 Επίδραση του Ιξώδους 

Παρακάτω θα παρουσιαστούν τα αποτελέσματα με την επίδραση του ιξώδες, 

καθώς και η συμπεριφορά της φυσαλίδας 

4.1.1 Αποτελέσματα για ε=0,2, ωf=959,4824 rad/s 

Από το σχήμα 1 προηγούμενης μελέτης [21] τα δεδομένα είναι: 
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  
  

Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας με ιξώδες για την συγκεκριμένη περίπτωση από την προσομοίωση στην 

υπολογιστική πλατφόρμα Fluent: 
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Διάγραμμα 4-1: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0,2 και ωf =959,4824 rad/s 
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Διάγραμμα 4-2: Μεταβολή του όγκου της φυσαλίδας για ε=0,2 και ωf =959,4824 rad/s 

Οι παρακάτω εικόνες παρουσιάζουν τις σημαντικότερες φάσεις της φυσαλίδας σε 

διαφορετικές χρονικές στιγμές υπό την παρουσία ιξώδους. Για ε=0.2 η φυσαλίδα 

ξεκινάει να συστέλλεται μέχρι να φτάσει τη μέγιστη συστολή και έπειτα συνεχίζει να 

διαστέλλεται μέχρι τη μέγιστη διαστολή. Στη συνέχεια συστέλλεται και αρχίζει να 

μετακινείται προς το τοίχωμα και στην επομένη χρονική στιγμή δημιουργείται μια 

χαλαρή εσοχή (jet) από τη δεξιά πλευρά Ακολουθούν οι φωτογραφίες της φυσαλίδας: 

 

 

Εικόνα 4-1: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 4-2: Μέγιστη συστολή της φυσαλίδας 

 

Εικόνα 4-3: Μέγιστη διαστολή της φυσαλίδας 



61 

 

 

Εικόνα 4-4: Μικρή συστολή και μετακίνηση της φυσαλίδας 

 

Εικόνα 4-5: Δημιουργία χαλαρής εσοχής (jet) στη φυσαλίδα 

Και παρακάτω γίνεται η σύγκριση τους με την υποενότητα 3.5.2 του όγκου της 

φυσαλίδας: 
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Διάγραμμα 4-3: Σύγκριση της μεταβολής του όγκου της φυσαλίδας με και χωρίς ιξώδες για ε=0,2 και 

ωf = 959,4824 rad/s 

Καθώς και του κέντρου μάζας με ή χωρίς ιξώδες: 
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Διάγραμμα 4-4: Σύγκριση της μεταβολής του κέντρου μάζας της φυσαλίδας με και χωρίς ιξώδες για 

ε=0,2 και ωf = 959,4824 rad/s 

Σαν πρώτη εκτίμηση φαίνεται ότι το ιξώδες έχει κάποια επίδραση στη 

συμπεριφορά της φυσαλίδας. Από το διάγραμμα του κέντρου μάζας φαίνεται ότι το 

ιξώδες βοηθάει την κίνηση της φυσαλίδας προς το τοίχωμα, ενώ όταν φτάνει κοντά 

στο τοίχωμα, είναι φανερό ότι καθυστερεί να πλησιάσει. Από το διάγραμμα του 

όγκου της φυσαλίδας φαίνεται ότι το ιξώδες τη διευκολύνει να κινηθεί, αλλά όχι 

ιδιαίτερα. 



63 

 

Παρακάτω παρουσιάζεται μια συλλογή από εικόνες σε διάφορες χρονικές 

στιγμές, με την παρουσία ιξώδους και χωρίς: 

 

Αρχικό μέγεθος (ιξώδες) Αρχικό μέγεθος (χωρίς ιξώδες) 

  
 

 

 

 

Μέγιστη συστολή (ιξώδες) Μέγιστη συστολή (χωρίς ιξώδες) 

  
 

Μέγιστη διαστολή (ιξώδες) Μέγιστη διαστολή (χωρίς ιξώδες) 
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Δημιουργία χαλαρής εσοχής (jet) (ιξώδες) Δημιουργία χαλαρής εσοχής (jet) (χωρίς 

ιξώδες) 

  

 

 

Μικρή συστολή και μετακίνηση (ιξώδες) Μικρή συστολή και μετακίνηση (χωρίς 

ιξώδες) 

 

  
Παρατηρείται ότι με την ύπαρξη του ιξώδους η φυσαλίδα επιτυγχάνει 

μεγαλύτερη διαστολή και μικρότερη συστολή σε σχέση με τη φυσαλίδα, η οποία 

βρίσκεται σε περιβάλλον ρευστό χωρίς ιξώδες. 

4.1.2 Αποτελέσματα για ε=0,2, ωf=94579,7554 rad/s 

Από το σχήμα 2 προηγούμενης μελέτης [21]τα δεδομένα είναι: 
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  
 

Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας με ιξώδες για αυτή την περίπτωση από την προσομοίωση στην 

υπολογιστική πλατφόρμα Fluent: 
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Διάγραμμα 4-5: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0,2 και ωf =9457,7554 rad/s 
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Διάγραμμα 4-6: Μεταβολή του όγκου της φυσαλίδας για ε=0,2 και ωf =9457,7554 rad/s 

Οι παρακάτω εικόνες παρουσιάζουν τις σημαντικότερες φάσεις της φυσαλίδας σε 

διαφορετικές χρονικές στιγμές. Για ε=0.2 και ωf=9457.7554 rad/s η φυσαλίδα 

ξεκινάει να συστέλλεται και έπειτα διαστέλλεται μέχρι τη μέγιστη διαστολή και στη 

συνέχεια συστέλλεται μέχρι τη μέγιστη συστολή. Ακολουθούν οι φωτογραφίες της 

φυσαλίδας: 
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Εικόνα 4-6: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 

 

Εικόνα 4-7: Μικρή συστολή της φυσαλίδας 
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Εικόνα 4-8: Μέγιστη διαστολή της φυσαλίδας 

 

Εικόνα 4-9: Μέγιστη συστολή της φυσαλίδας 

Εδώ γίνεται σύγκριση με την υποενότητα 3.5.3 του κέντρου μάζας: 
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Διάγραμμα 4-7: Σύγκριση της μεταβολής του κέντρου μάζας της φυσαλίδας με και χωρίς ιξώδες για 

ε=0,2 και ωf = 9457,7554 rad/s 

Εδώ γίνεται σύγκριση με και χωρίς ιξώδες του όγκου της φυσαλίδας: 
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Διάγραμμα 4-8: Σύγκριση της μεταβολής του όγκου της φυσαλίδας με και χωρίς ιξώδες για ε=0,2 και 

ωf = 9457,7554 rad/s 

Στη συγκεκριμένη περίπτωση δεν υπάρχει ιδιαίτερη διαφορά όσον αφορά το 

διάγραμμα των κέντρων μάζας. Από το διάγραμμα του όγκου της φυσαλίδας φαίνεται 
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ότι το ιξώδες τη διευκολύνει να κινηθεί, η όποια έχει και μεγαλύτερο πλάτος 

ταλάντωσης. 

Παρακάτω παρουσιάζεται μια συλλογή από εικόνες σε διάφορες χρονικές 

στιγμές, με την παρουσία ιξώδους και χωρίς: 

 

Αρχικό μέγεθος (ιξώδες) Αρχικό μέγεθος (χωρίς ιξώδες) 

  
 

 

Μικρή συστολή (ιξώδες) Μικρή συστολή  (χωρίς ιξώδες) 

  

 

Μέγιστη διαστολή (ιξώδες) Μέγιστη διαστολή (χωρίς ιξώδες) 
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Μέγιστη συστολή (ιξώδες) Μέγιστη συστολή (χωρίς ιξώδες) 

  

Παρατηρείται ότι με την ύπαρξη του ιξώδους η φυσαλίδα επιτυγχάνει 

μεγαλύτερη διαστολή και μικρότερη συστολή σε σχέση με τη φυσαλίδα, η οποία 

βρίσκεται σε περιβάλλον ρευστό χωρίς ιξώδες. 

 

4.1.3 Αποτελέσματα για ε=0,5, ωf=959,4824 rad/s 

Από τα δεδομένα προηγούμενης υπολογιστικής μελέτης με συνοριακά στοιχεία 

αλλά με την παρουσία ιξώδους: 

0

1 , 2 , 101325

0.5, 959,4824 / , 20526.31 /

st

f

r mm D mm P Pa

rad s rad s  

  

  
 

Παρακάτω ακολουθούν τα διαγράμματα του κέντρου μάζας και του όγκου της 

φυσαλίδας με ιξώδες για αυτή την περίπτωση από την προσομοίωση στην 

υπολογιστική πλατφόρμα Fluent: 
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Διάγραμμα 4-9: Μεταβολή του κέντρου μάζας της φυσαλίδας για ε=0,5 και ωf = 938 rad/s 
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Διάγραμμα 4-10: Μεταβολή του όγκου της φυσαλίδας για ε=0,5 και ωf = 938 rad/s 

Οι παρακάτω εικόνες παρουσιάζουν τις σημαντικότερες φάσεις της φυσαλίδας σε 

διαφορετικές χρονικές στιγμές. Για ε=0.5 η φυσαλίδα ξεκινάει να συστέλλεται μέχρι 

τη μέγιστη συστολή και έπειτα διαστέλλεται μέχρι τη μέγιστη διαστολή. Στη συνέχεια 

συστέλλεται και αρχίζει να μετακινείται προς το τοίχωμα και στην επομένη χρονική 

στιγμή δημιουργείται μια έντονη εσοχή (jet) από τη δεξιά πλευρά Ακολουθούν οι 

φωτογραφίες της φυσαλίδας: 

 

Εικόνα 4-10: Το αρχικό μέγεθος της φυσαλίδας στο πρώτο χρονικό βήμα 
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Εικόνα 4-11: Μέγιστη συστολή της φυσαλίδας 

 

Εικόνα 4-12: Μέγιστη διαστολή της φυσαλίδας 
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Εικόνα 4-13: Διαστολή και μετακίνηση της φυσαλίδας 

 

Εικόνα 4-14: Δημιουργία έντονης εσοχής (jet) στη φυσαλίδα 

Παρακάτω γίνεται σύγκριση με την υποενότητα 3.5.4 του κέντρου μάζας με την 

πάροδο του χρόνου: 
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Διάγραμμα 4-11: Σύγκριση της μεταβολής του κέντρου μάζας της φυσαλίδας με και χωρίς ιξώδες για 

ε=0,5 και ωf = 938 rad/s 

Και με μεγέθυνση σε συγκεκριμένη περιοχή του γραφήματος φαίνεται ακόμα 

καλύτερα, ότι δεν υπάρχουν ιδιαίτερες διαφορές μεταξύ τους: 
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Διάγραμμα 4-12: Μεγέθυνση της σύγκριση της μεταβολής του κέντρου μάζας της φυσαλίδας με και 

χωρίς ιξώδες για ε=0,5 και ωf = 938 rad/s 

Όσον αφορά τον όγκο της φυσαλίδας: 
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Διάγραμμα 4-13: Σύγκριση της μεταβολής του όγκου της φυσαλίδας με και χωρίς ιξώδες για ε=0,5 και 

ωf = 938 rad/s 

Και με μεγέθυνση σε συγκεκριμένη περιοχή του γραφήματος φαίνεται ακόμα 

καλύτερα, ότι δεν υπάρχουν ιδιαίτερες διαφορές. 
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Διάγραμμα 4-14: Μεγέθυνση της σύγκριση της μεταβολής του όγκου της φυσαλίδας με και χωρίς 

ιξώδες για ε=0,5 και ωf = 938 rad/s 

Σαν πρώτη εκτίμηση φαίνεται ότι το ιξώδες δεν έχει κάποια επίδραση στη 

συμπεριφορά της φυσαλίδας. Από το διάγραμμα του κέντρου μάζας φαίνεται ότι το 
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ιξώδες βοηθάει ελαφρώς την κίνηση της φυσαλίδας προς το τοίχωμα. Από το 

διάγραμμα του όγκου της φυσαλίδας φαίνεται ότι το ιξώδες τη διευκολύνει να 

κινηθεί. 

 

Αρχικό μέγεθος (ιξώδες) Αρχικό μέγεθος (χωρίς ιξώδες) 

  
 

 

 

Μέγιστη συστολή (ιξώδες) Μέγιστη συστολή (χωρίς ιξώδες) 

  
 

Μέγιστη διαστολή (ιξώδες) Μέγιστη διαστολή (χωρίς ιξώδες) 
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Διαστολή και μετακίνηση (ιξώδες) Διαστολή και μετακίνηση (χωρίς ιξώδες) 

  
 

Δημιουργία έντονης εσοχής (jet) (ιξώδες) Δημιουργία έντονης εσοχής (jet) (χωρίς 

ιξώδες) 

 

  
Παρατηρείται ότι με την ύπαρξη του ιξώδους η φυσαλίδα επιτυγχάνει 

μεγαλύτερη διαστολή και μικρότερη συστολή σε σχέση με τη φυσαλίδα, η οποία 

βρίσκεται σε περιβάλλον ρευστό χωρίς ιξώδες. Επίσης στη φυσαλίδα δημιουργούνται 

λιγότεροι και πιο χαλαροί σχηματισμοί στην επιφάνεια της με την επίδραση του 

ιξώδους. Αυτή η απόσβεση ενέργειας στην επιφάνεια διευκολύνει την κίνηση της 

φυσαλίδας μέσα στο ρευστό χωρίο. 

5. Συμπεράσματα-Προτάσεις για μελλοντική εργασία 

Στην παρούσα εργασία διαπιστώνεται ότι καθώς πλησιάζει η φυσαλίδα το 

τοίχωμα δημιουργείται μία υγρή δέσμη υψηλής ταχύτητας (jet) η οποία υπολογίζεται 

με μεγαλύτερη ευκρίνεια και ακρίβεια καθώς πυκνώνει το πλέγμα, η φορά της οποίας 

είναι ίδια με την κίνηση της φυσαλίδας προς το τοίχωμα. Αυτό τείνει να «κόψει» τη 

φυσαλίδα στη μέση, όπως έδειξαν εικόνες σε μεταγενέστερες χρονικές στιγμές. 

Λαμβάνοντας υπόψη το ιξώδες του νερού, παρατηρήθηκε ότι η φυσαλίδα εμφανίζει 

πιο ομαλές διαταραχές ενώ ταυτόχρονα μειώνεται η επιτάχυνσή της καθώς πλησιάζει 
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το τοίχωμα. Ταυτόχρονα υπάρχει απόσβεση της ενέργειας λόγω παραμόρφωσης της 

διεπιφάνειας της φυσαλίδας, η οποία και διευκολύνει την κίνηση της φυσαλίδας μέσα 

στο ρευστό χωρίο χωρίς την ανάπτυξη ασταθειών. Το ίδιο συμπέρασμα καταγράφηκε 

και από προηγούμενη μελέτη [10]. 

Επιπλέον υπάρχει απόσβεση των ταλαντώσεων όγκου της φυσαλίδας και για 

αυτό το λόγο, η μέγιστη διαστολή της φυσαλίδας χωρίς ιξώδες είναι πολύ μεγαλύτερη 

από την αντίστοιχη με ιξώδες και η συστολή της φυσαλίδας με ιξώδες είναι 

μικρότερη από την αντίστοιχη χωρίς ιξώδες. 

Η μέθοδος του όγκου ρευστού, όπως αυτή υλοποιείται στην πλατφόρμα της 

ANSYS, επιτρέπει την ακριβή αποτύπωση της χωρικής παραμόρφωσης και χρονικής 

εξέλιξης του φαινομένου. Από την σύγκριση με τους κώδικες συνοριακών στοιχείων, 

καθώς και από προηγούμενες μελέτες, καθίσταται σαφές ότι αποτελεί μια αξιόπιστη 

μέθοδο. 

Ο αριθμός λοβών και η δημιουργία ή μη «jet» είναι σημαντικά φαινόμενα, τα 

οποία δεν επηρεάζονται πολύ από την παρουσία του ιξώδους και τα οποία 

αναπαράγονται από τις αριθμητικές προσομοιώσεις. Συγκριτικά με την μέθοδο 

συνοριακών στοιχείων η ακρίβεια των υπολογισμών είναι συγκρίσιμη. Όμως η 

μέθοδος όγκου ελέγχου απαιτεί περισσότερο υπολογιστικό χρόνο λόγω της 

διακριτοποίησης ενός επιφανειακού χωρίου αντί για την διεπιφάνεια της φυσαλίδας 

όπως συμβαίνει στην περίπτωση των συνοριακών στοιχείων. Σημαντικό είναι επίσης 

να γίνει μελέτη πύκνωσης και αναπροσαρμογής του πλέγματος «grid adaption» 

καθώς και του χρονικού βήματος για την επίλυση μέσω της πλατφόρμας ANSYS, 

ώστε να γίνει εξαγωγή αποτελεσμάτων με καλύτερη ακρίβεια. 

Ως μελλοντική εργασία μπορεί να γίνει βελτίωση της τεχνικής του χρονικού 

βήματος, ώστε να υπάρχει καλύτερη ακρίβεια της μεθόδου του όγκου ρευστού. 

Ακόμα είναι πολύ σημαντικό να μπορέσει να μελετηθεί με τη χρήση του 

συγκεκριμένου υπολογιστικού πακέτου και η αλληλεπίδραση της φυσαλίδας με την 

παρουσία ελεύθερης επιφάνειας και όχι στερεού τοιχώματος. Τέλος θα ήταν 

ενδιαφέρον να ερευνηθεί η αλληλεπίδραση της φυσαλίδας με ελαστική μεμβράνη, 

παρουσία γειτονικού τοιχώματος, ώστε να γίνει σύζευξη με το πρόβλημα 

ελαστικότητας και να μελετηθεί η δυναμική εμφάνισης δέσμης ανάλογα με το είδος 

του γειτονικού τοιχώματος. 
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Παράρτημα 

 Οδηγίες δημιουργίας του μοντέλου αριθμητικής επίλυσης 

μέσω του πακέτου λογισμικού ANSYS Fluent 14.5.7 και χρήση 

των προγραμμάτων Workbench(WB), DesignModeler (DM), 

AnsysMeshing και Fluent. 

Η διαδικασία περιλαμβάνει τρία βασικά κομμάτια: 

1. Την προεπεξεργασία (Preprocessing). 

2. Τον επιλυτή (Solver). 

3. Την μεταεπεξεργασία (Postprocessing). 

1) Προεπεξεργασία (Preprocessing) 

1.1) Χρήση του Workbench 

1.1.1) Δημιουργία Project 

Γίνεται εκκίνηση του προγράμματος 

Workbench 

Έναρξη → Όλα τα προγράμματα → 

ANSYS 14.5 → Workbench 14.5 

Κλικ και «σέρνεται» από το Analysis 

Systems το Fluid Flow (Fluent) και 

τοποθετείται μέσα στο Project 

Schematic 

 

 

Διπλό κλικ στο Geometry κελί 

(Α2) για να γίνει εκκίνηση του 

προγράμματος DesignModeler 

(DM) 
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1.2) Εκκίνηση του προγράμματος DesignModeler  

1.2.1) Τοποθέτηση Μονάδων (S.I) 

Όταν γίνεται εκκίνηση του DesingModeler, το 

πρόγραμμα ζητάει πρώτα να οριστούν οι μονάδες 

με τις οποίες θα δημιουργηθεί το μοντέλο. 

Στη συγκεκριμένη περίπτωση θα 

χρησιμοποιηθούν τα χιλιοστά (millimeter). 

Στο Units specification box επιλέγεται 

millimeter. 

OK. 

 

1.2.2) Προετοιμασία 

Το μοντέλο θα γίνει σε δύο διαστάσεις. Θα δημιουργηθεί ένα μεγάλο 

παραλληλόγραμμο στις πλευρές του οποίου θα τοποθετηθούν αργότερα οι 

συνοριακές συνθήκες. Στην πάνω δεξιά πλευρά θα αποφευχθεί η γωνία, καθώς σε 

αυτό το σημείο θα ενώνονται οι δύο συνοριακές συνθήκες πίεσης. Για την εμπόδιση 

μεγάλων τιμών κοντά σε αυτά τα σημεία καθώς και αντίστροφη ροή θα δημιουργηθεί 

ένα τόξο που θα ενώνει τις δυο συνοριακές συνθήκες πίεσης. Παρακάτω φαίνεται το 

ολοκληρωμένο μοντέλο που θα δημιουργηθεί: 
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1.2.3) Δημιουργία Σχήματος (Sketch Creation)  

Δημιουργείται ένα σχήμα 

Στο Tree Outline, επιλέγεται το XY 

Plane. 

 

Κλικ στο Look At κουμπί στη γραμμή 

εργαλείων (toolbar). 
 

Επιλέγεται το Sketching Mode Tab. 

Με αυτό θα εμφανιστεί το Sketching 

Toolboxes. Πατώντας σε κάθε μπάρα που 

φαίνεται το όνομα της επιλογής, 

ενεργοποιείται και εμφανίζονται τα 

διαθέσιμα εργαλεία. 

Επιλέγεται το Draw Toolbox. 

 

 

Έπειτα κλικ πάνω στο Draw 

Toolbox και μετά στο Line και 

δημιουργείται ένα ορθογώνιο (είναι 

σημαντικό να είναι καλά ενωμένες 

οι τέσσερις γραμμές μεταξύ τους). 
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Κλικ πάνω στο Dimensions Toolbox και 

μετά στο General για να τοποθετηθούν 

οι διαστάσεις στο σχήμα. 

 

Στη συγκεκριμένη εργάσια το χωρίο 

είχε διαστάσεις 20 40mm mm και 

τοποθετήθηκαν όπως φαίνεται. 
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Για την πάνω δεξία γωνία, όπως προαναφέρθηκε, χρησιμοποιήθηκε Champfer για τη 

βελτίωση της σχεδίασης 

 

 

Κλικ πάνω στο Modify Tools και έπειτα στο Champfer. 

Επιλέγονται οι δύο πλευρές και ενεργοποιείται μόνο του. 
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1.2.4) Δημιουργία επιφάνειας 

Για να δημιουργηθεί το χωρίο θα πρέπει το σχήμα να γίνει επιφάνεια. Αυτό 

γίνεται όπως φαίνεται στο παρακάτω σχήμα. 

Κλικ στο Concept. 

έπειτα στο Surfaces from Sketches. 

 
 

Επειδή θα χρειαστεί να βελτιωθεί το πλέγμα παρακάτω, είναι απαραίτητο να 

δημιουργηθεί ένα Sketch 2, το οποίο με το Face Split θα είναι δυνατό να 

δημιουργηθούν δύο πλέγματα, το ένα με μεγάλο Skewness (κοντά στις συνοριακές 

συνθήκες της πίεσης) και το αλλό με μικρό Skewness και αρκετά πυκνό στο κομμάτι 

κοντά στο τοίχωμα, όπου θα κινηθεί η φυσαλίδα.  
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Στη συνέχεια από την Main Toolbar 

επιλέγεται το Tools→Face Split για να 

διαχωριστούν οι δυο επιφάνειες που 

δημιουργήθηκαν από το Sketch 2. 

 
 

Στο Face Split1 που δημιουργείται κλικ πάνω 

στις δύο επιφάνειας και μετά Generate 
 

 

Στο Target Face 

επιλέγεται η επιφάνεια 

που έχει δημιουργηθεί και 

στο Tool Geometry 

επιλέγεται η γραμμή από 

το Sketch 2.  

Αφού γίνει και το face Split θα δημιουργηθεί 

στο Tree Outline κάτω κάτω 1 Part, 1 Body και 

ακριβώς από κάτω το Surface Body  

1.2.5) Ονομασία Συνοριακών Συνθηκών (Named Selection) 

Αυτό είναι το οποίο χρησιμοποιείται ουσιαστικά σε όλη τη διαδικασία. Τελός για 

τη διευκόλυνση του σχεδιασμού, είναι καλό να χρησιμοποιείθει το Named Selection, 

όπου και θα ονομαστούν οι πλευρές που θα χρησιμοποιηθούν ως συνοριακές 

συνθήκες στο πρόβλημα. Παρακάτω φαίνονται: 
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Έπειτα επιλέγεται η πλευρά που 

χρειάζεται και ονομάζεται. Στη 

συγκεκριμένη εργασία ονομάστηκαν 

τρεις πλευρές: 

η αξονοσυμμετρία (axis) 

η συνοριακή συνθήκη της πίεσης 

(pressure) 

το τοίχωμα (wall). 

Και αυτές οι ονομασίες θα περάσουν 

στην επόμενη φάση της διαδικασίας. 

 

1.3) Εκκίνηση του προγράμματος ANSYS Meshing 

1.3.1) Προετοιμασία 

Αφού εμφανιστεί το πράσινο τικ στο Geometry, που σημαίνει ότι όλα είναι 

σωστά, μπορεί να συνεχιστεί η διαδικασία επιλέγονται το Mesh, το οποίο θα ανοίξει 

το ANSYS Meshing, στο οποίο γίνεται η δημιουργία του πλέγματος του χωρίου. 

Διπλό κλικ στο Geometry κελί (Α3) για 

να γίνει εκκίνηση του προγράμματος 

ANSYS Meshing.  

 
 

Στο τέλος της διαδικασίας δημιουργίας του πλέγματος θα είναι: 

 

Και το πλέγμα στο χωρίο θα είναι της παρακάτω μορφής: 
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Κάτω - κάτω είναι  πολύ πυκνό και γιαυτό το λόγο φαίνεται μάυρο. 

 

Με μεγέθυνση είναι φανερό ότι το πλέγμα στο κομμάτι, όπου θα κινηθεί η 

φυσαλίδα είναι κανονικό (structured mesh), ενώ πέρα από αυτή την περιοχή το 

πλέγμα είναι ακανόνιστο, καθώς δεν μας ενδιαφέρουν οι τιμές και επίσης 

χρησιμοποιήθηκε αυτή τη μορφή για λόγους ευκολίας και ταχύτητας, καθώς ένα πολύ 

πυκνό πλέγμα σε όλο το χωρίο θα καθυστερούσε τους υπολογισμούς και δεν θα 

υπήρχαν τα επιθυμητά αποτελέσματα.  
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1.3.2) Αρχικές Ρυθμίσεις 

Παρακάτω τίθενται: 

Solver Reference→ Fluent και τα 

υπόλοιπα είναι by default. Δεν θα 

χρειαστούν πολύ μεγάλες 

λεπτομέρειες για το πλέγμα. 

 
 

Φαίνονται ξεκάθαρα οι περασμένες Named Selections από το DesignModeler. Η 

συνοριακή συνθήκη της πίεσης (pressure), το τοίχωμα (wall) και η αξονοσυμμετρία 

(axis). 
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1.3.3) Δημιουργία του πλέγματος 

Για τη δημιουργία του Mesh γίνεται η εξής διαδικασία, η οποία φαίνεται και 

στην παρακάτω εικόνα: 
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Mesh→ Insert→ Method 

Έπειτα αφού επιλέγεται από το 

Geometry Selection το Body, επιλέγεται 

η μέθοδος Multizone Quad/Tri Method. 

 
 

 

Και τίθενται οι συγκεκριμένες ρυθμίσεςι. Στη συνέχεια Mesh→ Insert→ Sizing 
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Το Sizing θα χρησιμεύσει στο να επιλεχθεί ξεχωριστά η κάθε πλευρά του χωρίου 

για να δημιουργηθεί το πλέγμα. Για κάθε πλευρά δημιουργείται ένα Edge Sizing με 

τις απαραίτητες ρυθμίσεις ανάλογα τα χαρακτηριστικά της.  

Στο Type επιλέγεται το Number of 

Divisions και από κάτω τίθενται όσες 

επαναλήψεις είναι αναγκαίες. 

Το Behavior→Hard. 

Bias Type→No Bias. 

 
 

 

Παρακάτω φαίνεται ένα παράδειγμα του Edge Sizing για μία πλευρά: 
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1.3.4) Δημιουργία Inflation 

Έπειτα από το Mesh→Insert→Inflation 

δημιουργείται ένα Inflation, το οποίο θα 

βοηθήσει στην καλύτερη δημιουργία του 

πλέγματος. 

 
 

Έπειτα από το Mesh→ Insert→ 

Inflation. 

Στη κάτω εικόνα φαίνονται οι 

ρυθμίσεις που γίνονται για το 

Inflation. 

 

Μετά από το Boundary 

Scoping Method→ Named 

Selections. 

Boundary→ axis. 

Στο Inflation option→ First 

Layer Thickness. 

First Layer Height→ 
0033,5e mm . 

Growth Rate→ 1.08. 
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Επιλέγεται το κομμάτι στο οποίο θα γίνει το Inflation 

 

1.4) Εκκίνηση του προγράμματος ANSYS Fluent 

1.4.1) Προετοιμασία 

Στη συγκεκριμένη εργασία θα λυθεί το πρόβλημα με την μέθοδο VOF (Volume 

of Fluid). Παρακάτω φαίνονται ποια βασικά βήματα ακολουθήθηκαν για την σωστή 

εκτέλεση αυτής της μεθόδου. 

Εκκίνηση του Fluent, κάνοντας διπλό 

κλικ στο Setup. 

 
 

Ανοίγει ένας πίνακας, όπου 

επιλέγονται: 

στο Options→ Double Precision 

(για καλύτερη ακρίβεια). 

στο Processing Options→ Serial. 

επιβεβαιώνεται ότι στο 

Dimension→ 2D. 

και τέλος κλικ στο ΟΚ, όπου 

γίνεται εκκίνηση του ANSYS 

Fluent. 
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Αρχικά υπάρχει αυτό το σχήμα: 

 

Οι δύο κόκκινες γραμμές είναι η συνοριακή συνθήκη της πίεσης, η μαύρη 

αριστερά είναι το τοίχωμα και το κάτω μέρος του παραλληλογράμμου βρίσκεται η 

αξονοσυμμετρία. 

Καταρχάς γίνεται Scale στο πλέγμα για να σιγουρευτεί ότι υπάρχουν οι 

κατάλληλες μονάδες. 

 
Αμέσως μετά κλικ στο Solver→Type→ Pressure-Based (είναι ο επιλυτής που θα 

χρησιμοποιηθεί), Solver→Time→ Transient (το πρόβλημα είναι σε σχέση με το 

χρόνο), Solver→ 2D Space→ Axisymmetric (και θεωρείται αξονοσυμμετρία). Επίσης 

δεν γίνεται κλικ στο Gravity, καθώς δεν θα χρειαστεί η επίδραση της βαρύτητας στο 

μοντέλο.  
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Στο View Length Unit In φαίνεται ότι το μοντέλο είναι σε m. Αρχικά 

σχεδιάστηκε με βάση τα mm, αλλά το Fluent τα αναγνωρίζει ως μέτρα 

(20 40 0.02 0.04 )mm mm m m   . Είναι το ίδιο. 

Έπειτα γίνεται Check στο πλέγμα. 
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1.4.2) Διόρθωση όψης μοντέλου 

Θα διορθωθεί η όψη του μοντέλου, 

ώστε να μπορεί να φανεί και τι 

γίνεται από την άλλη πλευρά της 

αξονοσυμμετρίας. 

Επιλέγεται το Graphics and 

Animations στο Outline Tree. 

Κλικ στο Views. 

Στο παράθυρο που ανοίγει, κλικ 

στο front→ Auto Scale→ axis→ 

Apply. 

Με αυτό τον τρόπο τίθενται να 

γίνει το ίδιο ακριβώς μοντέλο και 

από το κάτω μέρος της 

αξονοσυμμετρίας  

Αυτό πλέον είναι το μοντέλο που εμφανίζεται: 
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1.4.3) Ρυθμίσεις VOF μοντέλου 

Παρακάτω φαίνεται η διαδικασία ενεργοποίησης του VOF μοντέλου. 

Ενεργοποίηση του VOF multiphase 

Model. 

Από το κεντρικό Tree Outline, κλικ 

στο Solution Setup→ Models→ 

Multiphase. 

Όταν ανοίξει ο πίνακας Multiphase 

Model, Multiphase  

Model→ Volume of Fluid 

Number of Eulerian Phases→ 2 

Volume Fraction Parameters → 

Explicit 

Body Force Formulation→ Implicit 

Body Force. 

Οκ. 

 
 

1.4.4) Επιλογή των κατάλληλων υλικών 

Πρέπει να προστεθεί το νερό στα υλικά. 

Από το κεντρικό Tree Outline, κλικ στο 

Solution Setup→ Materials→ Fluid. 

Κλικ πάνω στο Create/Edit. 

Στον πίνακα των υλικών, κλικ στο 

Fluent DATABASE. 

Επιλέγεται το water-liquid, από το 

Fluent Fluid Materials list, μετά κλικ στο 

Copy. 

Close. 

 

 

Μετά επειδή θεωρείται ιδανικό αέρα και όχι με σταθερή πυκνότητα κάνουμε 

την ίδια διαδικασία, μόνο που στο Density επιλέγεται το ideal-

gas→Change/Create→Close. 

 

Μετά επειδή θεωρείται ιδανικό αέρα και όχι με σταθερή πυκνότητα κάνουμε την 

ίδια διαδικασία, μόνο που στο Density επιλέγεται το ideal-gas→ Change/Create→ 
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Close. 

 

1.4.5) Ορισμός των δύο φάσεων 

Ενεργοποιούνται οι φάσεις από 

το Outline tree. 

Διπλό κλικ στο phase-1- 

Primary Phase 

Αλλάζεται το όνομα σε air. 

Βεβαιώνεται ότι από κάτω στο 

Phase Material έχει επιλεγεί το 

water-liquid 

Οκ. 

Διπλό κλικ στο phase-2- 

Secondary Phase 

Αλλάζεται το όνομα σε water  

Βεβαιώνεται ότι από κάτω στο 

Phase Material έχει επιλεγεί το 

air. 

Οκ. 
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1.4.6) Ορισμός της αλληλεπίδρασης των φάσεων 

 

Κλικ στο κουμπί Interaction 

Στον πίνακα Phase Interaction που ανοίγει, ενεργοποιείται το Surface tension tab 

(επιφανειακή τάση). 

Ενεργοποιείται το Surface Tension Force Modeling 

κλικ στο Continuum Surface Force. 

Επιλέγεται constant στη λίστα που κατεβαίνει και 

τίθεται ίση με 0.072 /N m  για τον συντελεστή επιφανειακής τάσης. 
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1.4.7) Ορισμός συνθηκών λειτουργίας 

Solution Setup→ Cell Zone 

Conditions 

Κλικ στο Operating Conditions… 

Και μετά βεβαιώνεται ότι η 

Operating Pressure (pascal) είναι 

ίση με 0. 

ΟΚ. 

 
 

1.4.8) Εισαγωγή UDF μέσω γλώσσας προγραμματισμού C 

Πριν γίνει αναφορά στις συνοριακές συνθήκες, καθώς και πως τέθηκαν, πρέπει 

να αναφερθεί πως δημιουργήθηκε το αρχείο στη γλώσσα προγραμματισμού C. Στη 

συνοριακή συνθήκη της πίεσης έπρεπε να οριστεί η εξίσωση:  1 cosAtm fP P t    , 

η οποία δεν υπάρχει στις έτοιμες εξισώσεις του Fluent. Παρακάτω φαίνεται πως 

δημιουργήθηκε η παραπάνω εξίσωση στο Microsoft Visual Studio. 
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Για να μπορέσει να περαστεί η εξίσωση αυτή στο Fluent ακολουθείται η 

παρακάτω διαδικασία: 

 

Define→ User-Defined→ Functions→ Interpreted… 

και στον πίνακα που ανοίγει 

 Browse… το αρχείο που έχει δημιουργηθεί 

κλικ στο Display Assembly Listing, ώστε να εμφανιστούν οι γραμμές κώδικα στο 

Fluent 
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και τέλος Interpret. 

1.4.9) Ορισμός συνοριακών συνθηκών 

Ο προσδιορισμός των συνοριακών συνθηκών απαιτεί δύο βήματα. Πρώτα 

χρησιμοποιείται η τιμή της πίεσης και των άλλων παραμέτρων στα κατάλληλα πεδία 

και μετά Apply. Σαν δεύτερο βήμα, επιλέγεται μία από τις δευτερεύουσες φάσεις από 

τη phase drop-down λίστα. Όταν γίνεται αυτό, η πίεση και τα άλλα πεδία 

απενεργοποιούνται και το volume fraction πεδίο γίνεται ενεργό. Τίθεται το 

κατάλληλο volume fraction και μετά Apply. 

Αρχικά θα οριστεί η συνοριακή συνθήκη της πίεσης. 

Στο κεντρικό tree Outline→ Boundary Conditions→ Pressure 

Phase→ mixture 

Type→ pressure-outlet 

και μετά Edit. 

Στο πίνακα που ανοίγει, Momentum→ Gauge Pressure(pascal)→ udf_The_Pressure 

(έτσι έχει ονομαστεί το αρχείο που δημιουργήθηκε για το σκοπό αυτό). 

Τέλος ΟΚ. 
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Όμως θα πρέπει να οριστεί και το VOF στη συγκεκριμένη συνοριακή συνθήκη. 

Οπότε: 

Στο κεντρικό tree Outline→ Boundary Conditions→ Pressure 

Phase→ water 

Type→ pressure-outlet 

και μετά Edit. 

Στον πίνακα που ανοίγει, στο Multiphase και στο Backflow volume fraction τίθεται 

το 1 (αυτό σημαίνει ότι θα εισάγεται ξανά νερό στην συνοριακή συνθήκη και όχι 

αέρας). 

Έπειτα ΟΚ. 

 
 

Τοποθετούνται και οι συνοριακές συνθήκες στον τοίχο. 

Στο κεντρικό tree Outline→ Boundary Conditions→ wall 

 Phase→ mixture 

Type→ wall 

και μετά Edit. 

Στο πίνακα που ανοίγει, Momentum→ Stationary wall. 

Και έπειτα ΟΚ. 
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1.4.10) Ορισμός αρχικών συνθηκών 

Έπειτα γίνεται η τοποθέτηση των 

αρχικών συνθηκών του προβλήματος. 

Στο κεντρικό tree Outline→ Solution→ 

Solution Initialization 

Initial Values→ Gauge Pressure (pascal) 

→101325 (1atm ουσιαστικά) 

water Volume Fraction→ 1 

και μετά Initialize. 

Ουσιαστικά το χωρίο γεμίζει όλο με 

νερό και έπειτα τοποθετείται η φυσαλίδα 

νερό μέσα σε αυτό. 
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1.4.11) Ορισμός της αρχικής λύσης 

Το επόμενο είναι να οριστεί η περιοχή του χωρίου η οποία θα περιέχει τη 

φυσαλίδα αέρα. Αυτό γίνεται με την εντολή Patch. Προτού γίνει patch η φυσαλίδα, 

πρέπει να οριστεί μέσα στο χωρίο. Οπότε: 

 

Στην κεντρική μπάρα εργαλείων 

Adapt→ Region… 

και στον πίνακα που ανοίγει τίθενται οι διαστάσεις της φυσαλίδας. 

Στο Input Coordinates→ X Center (m) → 0.004. 

αφού επιλέγονται στα Shapes→ Circle 

και στο  Radius (m) → 0.001. 

Τέλος κλικ στο Mark και θα εμφανιστεί ένα μήνυμα που θα αναφέρει τα εξής: 

 

Αυτό σημαίνει ότι δεσμεύτηκαν 336 κελία για να τοποθετηθεί εκεί η φυσαλίδα 

αέρα. 

 

Για να φανούν τα κελία που δεσμεύτηκαν: 
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Στο προηγούμενο πίνακα που υπήρχε, κλικ στο Manage… 

και στον πίνακα που εμφανίζεται, επιβεβαιώνεται το sphere-r0 

και κλικ στο Display για να εμφανιστεί. 

Στο συγκεκριμένο πρόβλημα επειδή υπάρχει αξονοσυμμέτρια τα 336 κελία που 

δεσμεύτηκαν, είναι από την πάνω πλευρά της αξονοσυμμετρίας. 

Σύνολο η φυσαλίδα στην παραπάνω εικόνα έχει 672 κελιά. 

 

1.4.12) Ορισμός ρυθμίσεων του Patch 

Παρακάτω θα αναφερθεί πως γίνονται οι ρυθμίσεις του Patch: 

 

Αφού έχουν επιβληθεί οι αρχικές συνθήκες και έχει οριστεί η φυσαλίδα μέσα στο 

χωρίο, γίνεται το patch της φυσαλίδας στις αρχικές συνθήκες. 

Κλικ στο patch και στον πίνακα που ανοίγει 

στο Phase→ water 

Variable→ Volume Fraction, Value→ 0, Registers to Patch→ sphere-r0 

και τέλος κλικ στο Patch. 

Με αυτόν τον τρόπο έχει οριστεί η φυσαλίδα μέσα στο χωρίο. Όμως λόγω της 

επιφανειακής τάσης πρέπει ως αρχική συνθήκη να οριστεί και η πίεση μέσα στη 

φυσαλίδα. Η πίεση θα είναι λίγο μεγαλύτερη από την 1 ατμόσφαιρα, δηλαδή 101469 

Pa. Αυτό φαίνεται στην παρακάτω εικόνα: 

 



109 

 

Στο Phase→ mixture, Variable→ Pressure, Value (pascal)→ 101469, Registers to 

Patch→ sphere-r0 

και τέλος κλικ στο Patch. 

Με αυτόν τον τρόπο έχει επιβληθεί η πίεση μέσα στη φυσαλίδα. 

 

Παρακάτω φαίνεται η σωστή τοποθέτηση των αρχικών συνθηκών του προβλήματος: 
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2) Επιλυτής (Solver) 

2.1) Ορισμός της μεθόδου λύσης 

Για τον επιλυτή δεν θα γίνουν ιδιαιτέρες αλλαγές, οπότε παρακάτω παρουσιάζεται 

απλά πως ορίζεται η μέθοδος λύσης. 

Στο κεντρικό tree Outline→ 

Solution→ Solution Methods. 

Scheme→ PISO 

Gradient→ Least Squared Cell Based 

Pressure→ PRESTO 

Momentum→ Second Order Upwind 

Volume Fraction→ Geo-Reconstruct. 

Με αυτές τις ρυθμίσεις θα γίνει η 

χωρική διακριτοποίηση (Spatial 

Discretization). 

 

3) Μεταεπεξεργασία (Postprocessing) 

Παρακάτω θα παρουσιαστεί η διαδικασία της μεταεπεξεργασίας. Θα 

δημιουργηθούν οι κατάλληλες επιφάνειες για τον υπολογισμό των μεγεθών που 

απαιτούνται, καθώς και  τους κατάλληλους ελεγκτές, οι οποίοι θα ελέγχουν τον όγκο 

της φυσαλίδας με το χρόνο και το κέντρο μάζας με το χρόνο. 

3.1) Ρύθμιση των στοιχείων παρουσίασης 

Στην αρχή χρησιμοποιήθηκε το Arrange the graphics window layout 

και τίθεται το εικονίδιο με το διπλό «παράθυρο» για να μπορούν να εμφανίζονται 

ταυτόχρονα 2 παράθυρα με τους ελεγκτές.  

 

 

 
3.2) Ρύθμιση Iso - Surface 

Πρώτα θα δημιουργηθούν οι επιφάνειες για να μπορούν με τη χρήση τους να 

τεθούν σωστά οι ελεγκτές. Με την εντολή Iso-Surface θα δημιουργηθεί η διεπιφάνεια 

μεταξύ του νερού και του αέρα. Αυτό γίνεται με την παρακάτω διαδικασία: 
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Στην κεντρική μπάρα, Surface→ Iso-Surface… και στον πίνακα που ανοίγει 

στο Surface of Constant→ Phases→ Volume fraction→ air 

και Iso-Value→0.5. 

Τοποθετείται και το όνομα αυτής της επιφάνειας στο New Surface Name. 

Στην συγκεκριμένη εργασία ονομάστηκε ως volume-fraction-5 

και έπειτα κλικ στο Create. 

Με αυτόν τον τρόπο δημιουργήθηκε η διεπιφάνεια. 

Τώρα θα δημιουργηθεί και η επιφάνεια που θα δείχνει την κατάσταση μέσα στη 

φυσαλίδα 

3.3) Ρύθμιση Iso - Clip 

 

Στην κεντρική μπάρα, Surface→ Iso-Clip… και στον πίνακα που ανοίγει, 

στο Clip to Values of→ Phases…→ Volume fraction→ air 

και σαν τιμή Min→ 0.5, Max→1. 

Τοποθετείται και το όνομα αυτής της επιφάνειας στο New Surface Name. 

Στην συγκεκριμένη εργασία ονομάστηκε ως clip-volume-fraction-6 

και έπειτα κλικ στο Clip. 

Με αυτό τον τρόπο δημιουργήθηκε μια επιφάνεια μέσα στην φυσαλίδα. 
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3.4) Ρύθμιση των Contours ( Παρακολούθηση φυσαλίδας) 

Αφού από τις παραπάνω ρυθμίσεις έχει ενεργοποιηθεί το δεύτερο παράθυρο, 

τοποθετείται η αρχική λύση. 

Στο tree outline→ Graphics and Animations→ Graphics→ Contours→ Set up… 

Στον πίνακα που ανοίγει, Contours of→ Phases…→ Volume fraction→ air 

και έπειτα Display. 

Το ότι εμφανίζεται ασπρόμαυρο και με 10 επίπεδα διαβάθμισης έγινε από την πιο 

κάτω εικόνα.  

 
 

Στο tree outline→ Graphics and 

Animations→ Colormap… 

και στον πίνακα που ανοίγει, Colormap 

Size→ 10 

Currently Defined→ gray 

και έπειτα Apply. 
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3.5) Ορισμός Ελεγκτών κέντου μάζας και όγκου φυσαλίδας 

Παρακάτω θα δημιουργηθούν οι δύο ελεγκτές που χρειάζονται για την 

παρακολούθηση του κέντρου μάζας και του όγκου της φυσαλίδας με τον χρόνο. 

Στο tree-outline→ Monitors→ Surface Monitors→ Create… 

και στον πίνακα που ανοίγει, Name→ center-of-mass 

Options→ Plot 

Window→3 

Write (File Name surf-mon-3.out) 

X-Axis→ Flow Time 

Get Dara Every→ 5 Time Step. 

Στο Report Type→ Area - Weighted Average. 

 Field Variable→ Mesh…→ X-coordinate 

και στο Surfaces→ clip-volume-fraction-6 

και έπειτα ΟΚ. 

 
 

Ο παρακάτω τύπος χρησιμοποιείται από το Fluent για να υπολογισει την 

ποσότητα που χρειάζεται: 
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Το Area- Weighted Average υπολογίζει αυτή την ποσότητα. Άμα όπου   

τοποθετηθεί το X-coordinate, ουσιαστικά υπολογίζεται το κέντρο μάζας. 

Επίσης παρακάτω παρουσιάζεται η διαδικασία για τη δημιουργία του ελεγκτή του 

όγκου της φυσαλίδας με το χρόνο. 

Στο tree-outline→ Monitors→ Volume Monitors→ Create… 

και στον πίνακα που ανοίγει, Name→ vol-mon-1 

Options→ Plot 

Window→4, 

Write→ (File Name vol-mon-1.out) 

X-Axis→ Flow Time 

Get Dara Every→ 5 Time Step. 

Στο Report Type→ Volume Integral 

Field Variable→ Phases…→ Volume fraction→ air 

Cell Zones→ fluid-surface_body 

και έπειτα ΟΚ. 
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Το Volume Integral υπολογίζει ουσιαστικά αυτή την ποσότητα σε όλο το χωρίο 

με αυτόν τον τρόπο. Όπου   είναι το κλάσμα όγκου της φυσαλίδας αέρα μέσα στο 

χωρίο. 
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3.6) Ορισμός των δραστηριοτήτων υπολογισμού 

Στο κεντρικό tree Outline→ Calculation Activities→ Autosave Every (Time Stepes) 

→ Edit… 

και στον πίνακα που ανοίγει στο Save Data File Every (Time Steps) → 50 (μπορεί 

να τεθεί να αποθηκεύει περισσότερα ή και λιγότερα από 50) 

και έπειτα κλικ στο ΟΚ. 

Στο ίδιο Calculation Activities→ Execute Commands→ Create/Edit… 

και στον πίνακα που ανοίγει, Defined Commands→ 1 

Active Name→ command-1 

Every→ 5, When→ Time Step 

και έπειτα ΟΚ. 
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3.7) Εισαγωγή monitor αποθήκευσης εικόνων - βίντεο 

Τώρα θα δημιουργηθεί το πως θα φαίνεται η λύση και επίσης να μπορεί να 

αποθηκευτούν και οι εικόνες από την όλη διαδικασία. 

Στο κεντρικό tree outline→ Calculation Activities→ Solution Animations→ 

Create/Edit… 

και στον πίνακα που ανοίγει, Animation Sequence→ 1 

Every→ 10 

When→ Time Step 

Define… και στον πίνακα που ανοίγει στο Sequence Parameters→ Window→2 

(είναι που θα εμφανίζεται το Solution Animation) 

Display Type→ Contours→ Edit… 

και στον πίνακα που ανοίγει, Contours of→ Phases…→ Volume fraction→ air 

και έπειτα Display. 
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3.8) Ορισμός ελεγκτή Residuals 

Έπειτα θα δημιουργηθεί και ο ελεγκτής των Residuals, οποίος θα εμφανίζεται στο 

πρώτο παράθυρο. 

Στο κεντρικό tree Outline→ Monitors→ Residuals-Print 

Plot→ Edit… 

και στον πίνακα που ανοίγει, τίθεται στο Window→ 1 

και έπειτα ΟΚ. 
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3.9) Τελευταίες ρυθμίσεις για έναρξη υπολογισμού (Run Calculation) 

Τέλος θα γίνουν οι τελευταίες ρυθμίσεις για να ξεκινήσει ο υπολογισμός. 

Στο κεντρικό tree Outline→ Run Calculation→ Check case… 

και στον πίνακα που ανοίγει αναφέρει: 

No recommendations to make at this time, που σημαίνει ουσιαστικά ότι δεν έχει γίνει 

κάποιο λάθος 

και μετά ΟΚ. 

 
 

Έπειτα στο κεντρικό tree Outline→ Run 

Calculation→ 

Time Step Size (s) → 1e-06 

Number of Time Steps→ 3500 

Options→ Extrapolate Variables 

Max Iterations/Time Step→ 5 

και τέλος Calculate. 
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3.10) Επεξεργασία εικόνων - βίντεο 

Μετά τον υπολογισμό μπορούν να γίνουν και κάποιες ενέργειες στα 

αποτελέσματα. Μια πολύ σημαντική ενέργεια που προσφέρει το ANSYS Fluent είναι 

να μπορεί κάποιος να δημιουργήσει βίντεο με τα αποτελέσματα την κάθε χρονική 

στιγμή, καθώς και την αποθήκευση εικόνων σε κάθε χρονικό βήμα. Η διαδικασία 

αυτή γίνεται όπως φαίνεται παρακάτω: 

Στο κεντρικό tree outline→ Graphics 

and Animations→ Solution 

Animation Playback→ Set up… 

και στον πίνακα που ανοίγει με το 

κουμπί Play, μπορεί να ξεκινήσει το 

βίντεο. 

και για αποθήκευση, Write/Record 

Format→ MPEG 

και έπειτα Write. 

Επίσης στην πιο κάτω εικόνα 

φαίνεται πως μπορεί να αποθηκευτεί 

η εικόνα σε κάθε χρονικό βήμα. 

 
 

Στο κεντρικό tree outline→ Graphics and Animations→ Solution Animation 

Playback→ Set up… 

και στον πίνακα που ανοίγει, Write/Record Format→ Picture Files 

και ακριβώς δίπλα, κλικ στο Picture Options… 

και στον πίνακα που ανοίγει μπορεί να επιλεγεί ο κατάλληλος τύπος που θα 

αποθηκευτεί η εικόνα. 

Επιλέγεται ο τύπος JPEG 

και μετά Apply. 
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3.11) Ορισμός Grid Adaption 

Τέλος αν χρειάζεται καλύτερη λεπτομέρεια στα αποτελέσματα μπορεί να γίνει 

Grid Adaption. Ένας από τους τρόπους που μπορεί να γίνει είναι: 

Στην κεντρική μπάρα Adapt→ Boundary… 

και στον πίνακα που ανοίγει, Options→ Normal Distance 

Distance Threshold (m) → 0.003 

Boundary Zones→ wall 

και έπειτα Adapt. 

Με αυτόν τον τρόπο έχει γίνει πυκνότερο το πλέγμα στα σημεία, όπου θα κινηθεί η 

φυσαλίδα μέχρι τον τοίχο.  

 
 

Επίσης στον πίνακα ελέγχου θα εμφανιστεί το συγκεκριμένο μήνυμα: 
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Ουσιαστικά αναφέρει πόσα κελιά χρησιμοποιούνται στο grid adaption. Τέλος 

έτσι είναι το πλέγμα μετά το grid adaption: 

 
Είναι σημαντικό να αναφερεθεί ότι το Grid Adaption πρέπει να γίνει στην αρχή, 

δηλαδή μετά το βήμα 1.4.12), όπου γίνεται το Patch της αρχικής λύσης. 
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3.12) Παράθεση αποτελέσματων και εικόνων στο περιβάλλον του Fluent 

Τέλος παρατίθενται κάποιες εικόνες μέσα από το ANSYS Fluent εφόσον 

τελείωσε σωστά ο υπολογισμός των παραμέτρων: 
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